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Copyright (c) 1998-2004 Intel Corporation
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE. THE EFI SPECIFICATION AND ALL OTHER INFORMATION
ON THIS WEB SITE ARE PROVIDED "AS IS" WITH NO WARRANTIES, AND ARE SUBJECT TO
CHANGE WITHOUT NOTICE.
You may not reverse-assemble, reverse-compile, or otherwise reverse-engineer any software
provided solely in binary form.
The foregoing license terms may be superseded or supplemented by additional specific license terms
found in the file headers of files in the EFI Application Toolkit.
GNU GENERAL PUBLIC LICENSE Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, Boston, MA
02110-1301 USA.
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it.
By contrast, the GNU General Public License is intended to guarantee your freedom to share and
change free software--to make sure the software is free for all its users. This General Public License
applies to most of the Free Software Foundation's software and to any other program whose authors
commit to using it. (Some other Free Software Foundation software is covered by the GNU Library
General Public License instead.) You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free software
(and charge for this service if you wish), that you receive source code or can get it if you want it, that
you can change the software or use pieces of it in new free programs; and that you know you can do
these things.
To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to
ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must give
the recipients all the rights that you have. You must make sure that they, too, receive or can get the
source code. And you must show them these terms so they know their rights.
We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which
gives you legal permission to copy, distribute and/or modify the software.
Also, for each author's protection and ours, we want to make certain that everyone understands that
there is no warranty for this free software. If the software is modified by someone else and passed on,
we want its recipients to know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.
Finally, any free program is threatened constantly by software patents. We wish to avoid the danger
that redistributors of a free program will individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.
The precise terms and conditions for copying, distribution and modification follow.
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION
AND MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright
holder saying it may be distributed under the terms of this General Public License. The "Program",
below, refers to any such program or work, and a "work based on the Program" means either the
Program or any derivative work under copyright law: that is to say, a work containing the Program or a
portion of it, either verbatim or with modifications and/or translated into another language.
(Hereinafter, translation is included without limitation in the term "modification".) Each licensee is
addressed as "you".
Activities other than copying, distribution and modification are not covered by this License; they are
outside its scope. The act of running the Program is not restricted, and the output from the Program is

covered only if its contents constitute a work based on the Program (independent of having been
made by running the Program). Whether that is true depends on what the Program does.
1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any
medium, provided that you conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to
the absence of any warranty; and give any other recipients of the Program a copy of this License
along with the Program.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based
on the Program, and copy and distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:
a) You must cause the modified files to carry prominent notices stating that you changed the files and
the date of any change.
b) You must cause any work that you distribute or publish, that in whole or in part contains or is
derived from the
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms
of this License.
c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and
telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but
does not normally print such an announcement, your work based on the Program is not required to
print an announcement.)
These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those sections when you distribute them
as separate works. But when you distribute the same sections as part of a whole which is a work
based on the Program, the distribution of the whole must be on the terms of this License, whose
permissions for other licensees extend to the entire whole, and thus to each and every part regardless
of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective works
based on the Program.
In addition, mere aggregation of another work not based on the Program with the Program (or with a
work based on the Program) on a volume of a storage or distribution medium does not bring the other
work under the scope of this License.
3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you also do one of the
following:
a) Accompany it with the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge
no more than your cost of physically performing source distribution, a complete machine-readable
copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)
The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus
any associated interface definition files, plus the scripts used to control compilation and installation of

the executable. However, as a special exception, the source code distributed need not include
anything that is normally distributed (in either source or binary form) with the major components
(compiler, kernel, and so on) of the operating system on which the executable runs, unless that
component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated place,
then offering equivalent access to copy the source code from the same place counts as distribution of
the source code, even though third parties are not compelled to copy the source along with the object
code.
4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License. However, parties who have
received copies, or rights, from you under this License will not have their licenses terminated so long
as such parties remain in full compliance.
5. You are not required to accept this License, since you have not signed it. However, nothing else
grants you permission to modify or distribute the Program or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program
(or any work based on the Program), you indicate your acceptance of this License to do so, and all its
terms and conditions for copying, distributing or modifying the Program or works based on it.
6. Each time you redistribute the Program (or any work based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the Program
subject to these terms and conditions. You may not impose any further restrictions on the recipients'
exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties
to this License.
7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of
this License. If you cannot distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you may not distribute the
Program at all. For example, if a patent license would not permit royalty-free redistribution of the
Program by all those who receive copies directly or indirectly through you, then the only way you could
satisfy both it and this License would be to refrain entirely from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people
have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this License may
add an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.
9. The Free Software Foundation may publish revised and/or new versions of the General Public
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of
this License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Program does not specify a version number of this License, you may choose any version ever

published by the Free Software Foundation.
10. If you wish to incorporate parts of the Program into other free programs whose distribution
conditions are different, write to the author to ask for permission. For software which is copyrighted by
the Free Software Foundation, write to the Free Software Foundation; we sometimes make
exceptions for this. Our decision will be guided by the two goals of preserving the free status of all
derivatives of our free software and of promoting the sharing and reuse of software generally.
NO WARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO
THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the
best way to achieve this is to make it free software which everyone can redistribute and change under
these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of each
source file to most effectively convey the exclusion of warranty; and each file should have at least the
"copyright" line and a pointer to where the full notice is found.
<one line to give the program's name and a brief idea of what it does.>
Copyright (C) <year> <name of author>
This program is free software; you can redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation; either version 2 of the License,
or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU General Public License for more details.
You should have received a copy of the GNU General Public License along with this program; if
not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301
USA
Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this when it starts in an interactive mode:
Gnomovision version 69, Copyright (C) year name of author Gnomovision comes with
ABSOLUTELY NO WARRANTY; for details type 'show w'. This is free software, and you are welcome
to redistribute it under certain conditions; type 'show c' for details.
The hypothetical commands 'show w' and 'show c' should show the appropriate parts of the General
Public License. Of course, the commands you use may be called something other than 'show w' and
'show c'; they could even be mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a
"copyright disclaimer" for the program, if necessary. Here is a sample; alter the names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the program'
Gnomovision' (which makes passes at compilers) written by James Hacker.
<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice
This General Public License does not permit incorporating your program into proprietary programs.
If your program is a subroutine library, you may consider it more useful to permit linking proprietary
applications with the library. If this is what you want to do, use the GNU Library General Public
License instead of this License.
・ Copyright (c) 1989 The Regents of the University of California.
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
must display the following acknowledgement:
This product includes software developed by the University of
California, Berkeley and its contributors.
4. Neither the name of the University nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ''AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
•

This is version 2004-May-22 of the Info-ZIP copyright and license. The definitive version of this
document should be available at ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely.

Copyright (c) 1990-2004 Info-ZIP. All rights reserved.
For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of
individuals:
Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly,
Hunter Goatley, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath,
Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor
Mandrichenko, Steve P. Miller, Sergio Monesi, Keith Owens, George Petrov, Greg Roelofs,
Kai Uwe Rommel, Steve Salisbury, Dave Smith, Christian Spieler, Antoine Verheijen, Paul
von Behren, Rich Wales, Mike White
This software is provided "as is," without warranty of any kind, express or implied. In no event
shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or
consequential damages arising out of the use of or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial

applications, and to alter it and redistribute it freely, subject to the following restrictions:
• Redistributions of source code must retain the above copyright notice, definition,
disclaimer, and this list of conditions.
•

•

•

Redistributions in binary form (compiled executables) must reproduce the above
copyright notice, definition, disclaimer, and this list of conditions in documentation and/or
other materials provided with the distribution. The sole exception to this condition is
redistribution of a standard UnZipSFX binary (including SFXWiz) as part of a
self-extracting archive; that is permitted without inclusion of this license, as long as the
normal SFX banner has not been removed from the binary or disabled.
Altered versions--including, but not limited to, ports to new operating systems, existing
ports with new graphical interfaces, and dynamic, shared, or static library versions--must
be plainly marked as such and must not be misrepresented as being the original source.
Such altered versions also must not be misrepresented as being Info-ZIP
releases--including, but not limited to, labeling of the altered versions with the names
"Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations),
"Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such
altered versions are further prohibited from misrepresentative use of the Zip-Bugs or
Info-ZIP e-mail addresses or of the Info-ZIP URL(s).
Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," "WiZ,"
"Pocket UnZip," "Pocket Zip," and "MacZip" for its own source and binary releases.

・ This product includes Zip which has been modified from Pocket Zip (Info-Zip).
・ This product includes JRE (Java Runtime Environment) software distributed free-of-charge from
Oracle Corporation, and software (Xerces-C++ Version 3.1.1) distributed free-of-charge from
Apache Software Foundation. We ask that you use these products upon agreement with the
respective license agreements. For details regarding copyrights and proprietary rights, refer to the
license files below:
JRE: <Directory in which JRE is installed>: \LICENSE
Xerces-C++ Version 3.1.1: The Xerces-C++ Version 3.1.1 is available in both source distribution
and binary distribution. Xerces-C++ is made available under the Apache Software License,
Version 2.0.
http://www.apache.org/licenses/LICENSE-2.0.html
・ This product includes software distributed for free (log4net for .NET Framework 2.0 Version
1.2.10.0) by Apache Software Foundation.
For details regarding copyrights and proprietary rights, refer to the files below:
For SSC product, <Install media>: \DPM\License\log4net for .NET Framework 2.0\
For DPM unbundled product, <Install media>: \License\log4net for .NET Framework 2.0\
・ This product includes software distributed for free (Spring.Net Core functionality Version
1.2.0.20313) by SpringSource.
For details regarding copyrights and proprietary rights, refer to the files below:
For SSC product, <Install media>: \DPM\License\Spring.Net Core functionality\
For DPM unbundled product, <Install media>: \License\Spring.Net Core functionality\
・ This product includes software distributed for free (Prototype JavaScript framework, version
1.6.0.3) by Prototype Core Team.
For details regarding copyrights and proprietary rights, refer to the below:
==========================================================================
Prototype is freely distributable under the terms of an MIT-style license.
For details, see the Prototype web site: http://www.prototypejs.org/
==========================================================================
・ This product includes software distributed for free (Tree Container Library(TCL) Version 5.0.6) by
Datasoft Solutions.
･

It was downloaded from
ftp://ftp.ie.u-ryukyu.ac.jp/pub/software/kono/nkf171.shar
ftp://ftp.iij.ad.jp/pub/NetNews/fj.sources/volume98/Nov/981108.01.Z

Subject: nkf 1.7 (Network Kanji Filter w/Perl Extenstion)
Message-ID: <29544.910459296@rananim.ie.u-ryukyu.ac.jp>
Copyright:
Copyright (C) 1987, Fujitsu LTD. (Itaru ICHIKAWA)
(E-Mail Address: ichikawa@flab.fujitsu.co.jp)
Copyright (C) 1996,1998 Kono, COW
(E-Mail Address: kono@ie.u-ryukyu.ac.jp)
Everyone is permitted to do anything on this program
including copying, modifying, improving.
as long as you don't try to pretend that you wrote it.
i.e., the above copyright notice has to appear in all copies.
You don't have to ask before copying or publishing.
THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE.
･

ORIGINAL LICENSE:
This software is
(c) Copyright 1992 by Panagiotis Tsirigotis
The author (Panagiotis Tsirigotis) grants permission to use, copy,
and distribute this software and its documentation for any purpose
and without fee, provided that the above copyright notice extant in
files in this distribution is not removed from files included in any
redistribution and that this copyright notice is also included in any
redistribution.

Modifications to this software may be distributed, either by distributing
the modified software or by distributing patches to the original software,
under the following additional terms:
1. The version number will be modified as follows:
a. The first 3 components of the version number
(i.e <number>.<number>.<number>) will remain unchanged.
b. A new component will be appended to the version number to indicate
the modification level. The form of this component is up to the
author of the modifications.
2. The author of the modifications will include his/her name by appending it
along with the new version number to this file and will be responsible for
any wrong behavior of the modified software.
The author makes no representations about the suitability of this software for any purpose. It is
provided "as is" without any express or implied warranty.
Modifications:
Version: 2.1.8.7-current
Copyright 1998-2001 by Rob Braun
Sensor Addition
Version: 2.1.8.9pre14a
Copyright 2001 by Steve Grubb
This is an excerpt from an email I received from the original author, allowing
xinetd as maintained by me, to use the higher version numbers:

I appreciate your maintaining the version string guidelines as specified

in the copyright. But I did not mean them to last as long as they did.
So, if you want, you may use any 2.N.* (N >= 3) version string for future
xinetd versions that you release. Note that I am excluding the 2.2.* line;
using that would only create confusion. Naming the next release 2.3.0
would put to rest the confusion about 2.2.1 and 2.1.8.*.
•

•

•
•
•
•

Some icons used in this program are based on Silk Icons released by Mark James under a
Creative Commons Attribution 2.5 License. Visit http://www.famfamfam.com/lab/icons/silk/ for
more details.
The Cygwin DLL and utilities are Copyright © 2000, 2001, 2002, 2003, 2004, 2005, 2006, 2007,
2008, 2009, 2010, 2011 Red Hat, Inc. Other packages have other copyrights.
UNIX® is a registered trademark of the Open Group in the United States and other countries.
Copyright (C) 2001-2003 Hewlett-Packard Co.Contributed by Stephane Eranian
eranian@hpl.hp.com
Copyright 1994-2008 H. Peter Anvin - All Rights Reserved
All other company names and product names mentioned in this document are trademarks or
registered trademarks of the respective companies.
Each source and binary file stored on the install media is affiliated with the respective source and
binary file license.

Contents
Introduction .......................................................................................................................... xiii
Target Audience and Purpose ......................................................................................................... xiii
Document Structure......................................................................................................................... xiii
DeploymentManager Manual Organization ...................................................................................... xiv
Documentation Guidelines ............................................................................................................... xv

1.

Before Installing DPM ................................................................................................... 3

1.1.
1.2.

DeploymentManager Ver6.0 DVD Configuration .................................................................. 4
Before Installing DPM.......................................................................................................... 5

1.2.1.Installing Internet Information Services (IIS) ......................................................................................... 6
1.2.2.Setting Up the DHCP Server ............................................................................................................... 11

2.

Installing DPM ............................................................................................................... 13

2.1.

Installing the DPM Server .................................................................................................... 14

2.1.1.Installing the DPM Server by Standard Installation ............................................................................... 18
2.1.2.Installing the DPM Server by Custom Installation ................................................................................. 30

2.2.

Installing the DPM Client ..................................................................................................... 32

2.2.1.Installing the Windows (IA32/EM64T) Version ...................................................................................... 33
2.2.2.Installing the Linux (IA32/EM64T) Version............................................................................................ 35

2.3.

Installing Image Builder (Remote Console) .......................................................................... 39

2.3.1.Installing Image Builder (Remote Console) by Standard Installation ...................................................... 39
2.3.2.Installing Image Builder (Remote Console) by Custom Installation ........................................................ 43

2.4.
2.5.

Installing DPM Command Line ............................................................................................ 45
Installing PackageDescriber ................................................................................................ 49

2.5.1.Installing PackageDescriber by Standard Installation............................................................................ 49
2.5.2.Installing PackageDescriber by Custom Installation .............................................................................. 53

3.

Upgrading DPM ............................................................................................................. 55

3.1.

Before Upgrading DPM ....................................................................................................... 56

3.1.1.Upgrading Precautions ........................................................................................................................ 56

3.2.
3.3.

Upgrading the DPM Server.................................................................................................. 58
Upgrading the DPM Client ................................................................................................... 66

3.3.1.Automatically Upgrading the DPM Client .............................................................................................. 66
3.3.2.Manually Upgrading the DPM Client .................................................................................................... 68

3.4.
3.5.
3.6.
3.7.

4.

Upgrade install of Image Builder (Remote Console) ............................................................. 72
Upgrading DPM Command Line .......................................................................................... 76
Upgrading PackageDescriber .............................................................................................. 79
Precautions: Upgrading from DPM Ver4.0/4.1/4.2/4.3 .......................................................... 82

Uninstalling DPM .......................................................................................................... 83

4.1.

Before Uninstalling DPM ..................................................................................................... 84

4.1.1.Uninstall Precautions........................................................................................................................... 84

4.2.
4.3.

Uninstalling the DPM Server................................................................................................ 84
Uninstalling the DPM Client ................................................................................................. 86

4.3.1.Uninstalling the Windows (IA32/EM64T) Version .................................................................................. 86
4.3.2.Uninstalling the Linux (IA32/EM64T) Version ....................................................................................... 89

4.4.
4.5.
4.6.

5.

Uninstalling Image Builder (Remote Console) ...................................................................... 91
Uninstalling DPM Command Line ........................................................................................ 93
Uninstalling PackageDescriber ............................................................................................ 95

Preparing for DeploymentManager Operation ............................................................ 101

5.1.

Preparing for DPM Operation .............................................................................................. 102

5.1.1.Starting the Web Console.................................................................................................................... 102
5.1.2.Logging into DPM ............................................................................................................................... 103
5.1.3.Setting up Login Users ........................................................................................................................ 104

xi

5.1.4.Registering the License Key ............................................................................................................... 105

Appendix A

Silent Installation ..........................................................................................109

Installing, Upgrading, and Uninstalling the DPM Server ................................................................... 111
Installing the DPM Client ................................................................................................................. 113

Appendix B

Setting Up the Package Web Server............................................................117

Appendix C

Setting up Multicast Protocol ......................................................................131

Appendix D

Setting up the DHCP Relay Agent ...............................................................133

Appendix E

NFS Server Configuration ............................................................................135

Appendix F

Upgrading the Database...............................................................................137

Appendix G

Revision History ...........................................................................................139

xii

Introduction
Target Audience and Purpose
This "Installation Guide" is intended for system administrators who perform DPM installation, upgrade
installation, uninstallation, and initial setup, and explains the various methods thereof.

Document Structure
Part I DeploymentManager Installation Process
1
2
3
4

Before Installing DPM: Carefully read this section prior to installation.
Installing DPM: This section describes how to install DPM.
Upgrading DPM: This section describes how to upgrade DPM from your present version.
Uninstalling DPM: This section describes how to uninstall DPM.

Part II Environment Configuration
5

Preparing for DeploymentManager Operation: This section describes how to configure the initial
setup for DPM.

Appendices
Appendix A
Appendix B
Appendix C
Appendix D
Appendix E
Appendix F
Appendix G

"Silent Installation"
"Setting Up the Package Web Server"
"Setting up Multicast Protocol"
"Setting up the DHCP Relay Agent"
"NFS Server Configuration"
"Upgrading the Database"
"Revision History"
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DeploymentManager Manual Organization
DPM manuals are structured as described below.
In addition, the various manuals in this publication are listed according to the "Name in this Manual".
Name of Manual

Name in this Manual

DeploymentManager
Ver6.0 First Step Guide

First Step Guide

DeploymentManager
Ver6.0 Installation Guide

Installation Guide

DeploymentManager
Ver6.0 Operation Guide

Operation Guide

DeploymentManager
Ver6.0 Reference Guide

Reference Guide

Role of Manual
Intended for DPM users. Provides a product
overview, and describes the various
functions, system design methods,
operating environment, and the like.
Intended for system administrators who
install DPM. Describes tasks such as how to
install, upgrade, and uninstall DPM.
Intended for system administrators who
operate DPM. Describes the operation
environment setup procedure as well as the
various operations performed when
operating the program based on an actual
operation flow.
Intended for system administrators who
operate DPM. Describes DPM screen
operations, tools, maintenance-related
information, and troubleshooting. This guide
is a supplement to the Installation Guide and
the Operation Guide.

The latest information of DPM can be acquired from the following product site:
http://www.nec.com/masterscope/deploymentmanager/
The Reference Guide is not included in the install media, and is only available on the
product site..

xiv

Documentation Guidelines
The following describes important points regarding the notation used in this manual.
・ The notation used for DPM products is as follows:
Notation in this Manual
Product Name
DPM unbundled product
DeploymentManager Ver6.0
SSC product
DeploymentManager Ver6.0 for SSC(*1)
*1
This is a product that is bundled with SigmaSystemCenter and VirtualPCCenter.
・ The screen images in this manual are based on the DPM unbundled product. The license
related displays are only for the DPM unbundled product. They are not displayed for SSC
products.
・ Product versions and revisions are expressed as follows.
Example)For DPM Ver6.0, "6" refers to the version and "0" refers to the revision.
・ The install media included with the DPM product is called "Install Media" in this manual.
・ IA32 architecture is displayed as "IA32" in this manual and EM64T architecture as "EM64T".
・ The path used to install DPM on IA32 and EM64T is different for the Windows OS. The IA32
environment is used as a general rule in this manual so please replace it when you read it.
Example)
•For IA32:C:\Program Files\NEC\DeploymentManager
•For EM64T:C:\Program Files (x86)\NEC\DeploymentManager
・ The registry path for IA32 and EM64T is different for the Windows OS. The IA32 environment is
used as a general rule in this manual so please replace it when you read it.
Example)
•For IA32:HKEY_LOCAL_MACHINE\SOFTWARE
•For EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node
・ The SQL Server mentioned in this manual is based on SQL Server 2008 R2 Express that is
included in the install media so please replace it when you read it.
Example)
DPM database path
•For SQL Server 2008 R2 Express x86:
C:\Program Files\Microsoft SQL Server\MSSQL10_50.DPMDBI\MSSQL\Binn
•For SQL Server 2005 Express Edition x86:
C:\Program Files\Microsoft SQL Server\MSSQL.x\MSSQL\Binn

xv

・ The meaning of each icon used in this manual is as follows:
Important messages alert you to cautionary or warning items related to functions,
operations, and settings. These are items that are especially important for the
operation of DPM.
Note messages alert you to cautionary items related to functions, operations, and
settings.
Complementary items for operation such as convenient functions.
・ The displays and procedures of DPM may differ according to the operating system used. This
document is based on Windows Server 2008 and Windows 7, in principle. Read the displays
and procedures as those that appear in your operating system. (In part, there may be mention of
operating systems prior to Windows Server 2008 and Windows 7.)
Example)
The procedure for checking the DPM version differs by operating system as follows:
･For Windows Server 2008:
1) From the Start menu, click Control Panel -> Programs and Features.
2) Select View -> Choose details.
3) On the Choose Details screen, check the Version check box and click the OK button.
･For Windows 7:
1) From the Start menu, click Control Panel -> Programs and Features.
2) Right-click Name that appears in the center of your screen, and select More.
3) On the Choose Details screen, check the Version check box and click the OK button.
･For an OS other than the above
1) From the Start menu, click Control Panel -> Add or Remove Programs.
2) Select the applicable component, and click on Click here for support information.
・ Windows Server 2003 R2/Windows Server 2008 R2 will not be explained, so please replace
Windows Server 2003/Windows Server 2008 when you read it.
・ In descriptions of screen operation procedures, arbitrary names to be specified by the user
appear in bold and italics as follows: Scenario Group.
Example)
In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
・ The version of JRE shown on the screen may not be the latest that DPM can use. Read the
displays and procedures as those that appear in your operating system.
・ Please carry out following procedures when Finish DPM related tasks appears in this
document. Please add the following value if it exists.
•If a scenario is running, wait until the scenario ends.
•If an automatic update is in progress, wait until the automatic update ends.
•f you are operating the Web Console or the various DPM tool types, please end them.
・ 1MByte is calculated as 1024Kbyte.
1GByte is calculated as 1024Mbyte.
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This section describes how to install, upgrade, and uninstall DPM.
•
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•

1
2
3
4

Before Installing DPM. .............................................................................................3
Installing DPM. ...................................................................................................... 13
Upgrading DPM ..................................................................................................... 55
Uninstalling DPM ................................................................................................... 83
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1.

Before Installing DPM

This chapter describes how to read this manual and outlines the precautionary notes for DPM
installation.
The items covered in this chapter are as follows:

•
•

1.1
1.2

DeploymentManager Ver6.0 DVD Configuration. ..................................................... 4
Before Installing DPM. .............................................................................................5
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1 Before Installing DPM

1.1. DeploymentManager
Configuration

Ver6.0

DVD

The DPM installer and software components are provided on the DPM Ver6.0 install media DVD as
follows. The following is the DPM Ver6.0 unbundled product configuration.
DeploymentManager 6.0 DVD
|
|- dotNet Framework35 SP1
|
|
|- License
|
|
|- Linux
|
|
|- MANUAL
|
|
|- Setup
|
|
L TOOLS

Linux related module

Autorun.inf
autorun.exe
Launch.exe

Launcher execution module

.NET Framework 3.5 Service Pack 1 re-distributable package

Product license for the OSS module bundled with the product

User´s guide
Setup module

Tools

DeploymentManager Ver6.0 Installation Guide
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1.2. Before Installing DPM
Before installing DPM, check and set up the following.
Item

When Checking Is Required

Check system configuration/
operating environment

Before installing DPM

Set up network environment

Before installing DPM

Installing Internet Information
Services (IIS)

When IIS is not installed on the
management server

Setting Up the DHCP Server

When operation employs the
DHCP server

Set the Package Web Server

When the package is centrally
managed across multiple
management servers
In the following case:
•When multicast protocol is used
and
•When a managed machine of
multiple subnets beyond the
router is managed and
software-routed by DPM (*)
In the following case:
•When operation employs the
DHCP server
and
•When a managed machine of
multiple subnets beyond the
router is managed and
software-routed by DPM (*)
When the OS clear installation
(Linux) function is used

Setting Up Multicast Protocol

Setting Up the DHCP Relay
Agent

NFS Server Configuration

Reference
Section 2.1, "
DeploymentManager
System Configuration
Examination," in First
Step Guide
Section 2.2.1, "
Regarding the Network
Environment," in First
Step Guide
Section 1.2.1, "Installing
Internet Information
Services (IIS)," in this
manual
Section 1.2.2, "Setting
Up the DHCP Server,"
in this manual
Appendix B, "Setting Up
the Package Web
Server," in this manual
Appendix C, "Setting Up
the Multicast Protocol,"
in this manual

Appendix D, "Setting Up
the DHCP Relay
Agent," in this manual

Appendix E, "NFS
Server Configuration" in
this manual
*For setup when routing is performed using hardware devices (routers or switches), see the
manuals of the respective devices.
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1.2.1.

Installing Internet Information Services (IIS)

•Installing IIS 6.0 (Windows Server 2003)
(1) From the Start menu, select Control Panel, and select Add or Remove Programs.
(2) Click Add/Remove Windows Components. The Windows Components Wizard screen
appears. Select Application Server and then click on the Details button.
(3) The Application Server screen appears. Check Internet Information Services (IIS), and click
on the OK button.
(4) The screen returns to the Windows Components Wizard screen. Click on the Next button. The
processing is executed and the Finish button appears. Installation is now finished. (Microsoft OS
Installer CD-ROM required).
•Installation method for IIS 7.0 (Windows Server 2008)/IIS7.5 (Windows Server 2008 R2)
If Web Server (IIS) is already installed, please confirm whether Static Content,
ASP.NET and IIS 6 Metabase Compatibility are installed by selecting Role Service
in Web Server (IIS). Please install the components that are not installed if there is
not at least one installed.
(1) From the Start menu, select Administrative Tools -> Server Manager.
(2) The Server Manager screen appears. Select Roles on the left-hand pane, and then click Add
Roles on the right-hand pane.
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(3) The Add Roles Wizard appears. Click on the Next button.

(4) The Select Server Roles screen appears. Select Web Server (IIS).
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(5) The following screen appears. Click on the Add Required Features button.

(6) The screen returns to the Select Server Roles screen. Click on the Next button.
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(7) On the Web Server (IIS) screen, click on the Next button.

(8) On the Select Role Services screen, check Static Content, ASP.NET and IIS6 Metabase
Compatibility and click on the Next button.
(9) On the Confirm Installation Selections screen, click on the Install button.
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(10) On the Installation Results screen, check the installation details and click on the Close button.
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1.2.2.

Setting Up the DHCP Server

When operation is to be performed using a DHCP server, DHCP service installation and setup are
required.
The following describes an example of how to set up a DHCP server on Windows Server 2003.
<DHCP (Dynamic Host Configuration Protocol) Installation Procedure>
If a DHCP server is not installed, install the DHCP service following the procedure below.
(1) From the Start menu, select Settings, and select Control Panel, and then select Add or
Remove Programs.
(2) Click Add/Remove Windows Components to start the Windows Components Wizard.
(3) Click Networking Services, and click on the Details button.
(4) Check Dynamic Host Configuration Protocol (DHCP), and click on the OK button.
(5) The screen returns to the Windows Components Wizard screen. Click on the Next button.
Installation starts.
(6) After installation ends, click on the Finish button.
The DHCP server is now installed.
<DHCP Setup Procedure>
(1) From the Start menu, select Programs -> Administrative Tools -> DHCP.
(2) In the console tree, right-click DHCP and select Add Server.
(3) The Add Server screen appears. Either enter or select from the Browse button the computer
name of the server that you want to set as the DHCP server, and click on the OK button.
(4) The added server appears in the console tree. Right-click the added server, and click on New
Scope.
(5) The New Scope wizard appears. Click on the Next button.
(6) Scope Name appears. Enter the name and description, and click on the Next button.
(7) IP Address Range appears. Set up the start and end IP addresses, and click on the Next button.
Set up the subnet mask if you want to change the network/subnet ID and host ID
quantity.
Prepare IP addresses in an amount equivalent to the number of managed machines
by DPM. If machines other than those managed by DPM obtain an IP from the
DHCP, please ensure that there are a sufficient number of IP addresses. Scenarios
may not run normally if there are insufficient IP addresses.
(8) Add Exclusions appears. Enter the range of IP addresses that you want to exclude and click on
the Next button.
(9) Lease Duration appears. Set up the duration in which you want to lease the IP addresses and
click on the Next button.
Part I DeploymentManager Installation Process
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Under normal conditions, the default value of 8 days will not be a problem.
(10) Configure DHCP Options appears. If you want to configure the DHCP options of this scope now,
select Yes, I want to configure these options now, and click on the Next button. If you want to
configure the options later, select No, I will configure these options later and click on the Next
button.
Add options if there are options that are required.
The DHCP server is now set up.
<DHCP Server Construction Precautions>
If you want to construct the DHCP server using a server other than the DHCP server that comes with
Windows Server 2003 and Windows Server 2008 as standard, note the following:
Use of fixed addresses
When the DHCP server is constructed using Linux, for example, you may need to specify a fixed
address in /etc/dhcpd.conf.
A fixed address refers to a mechanism wherein the MAC address of the managed machine and the IP
address to be leased are combined and registered in the DHCP server in advance, and the DHCP
server leases the fixed IP address in response to an address request from the managed machine.
If there is no description of the fixed address, a response delay from the DHCP server may occur. In
that case, the PXE boot (network boot) will fail and DPM may not behave properly due to the affect.
For UNIX operating systems other than Linux, a fixed address may be similarly required.
The following shows an example of /etc/dhcpd.conf in a case where a fixed address (192.168.0.32) is
specified for the MAC address (12:34:56:78:9A:BC) host.
subnet 192.168.0.0 netmask 255.255.255.0 {
...
...
host computer-name {
hardware ethernet 12:34:56:78:9A:BC;
fixed-address 192.168.0.32;
}
}
You cannot install or use DHCP server software manufactured by a third party on the
same device.
If you want to install the software on another device, be sure to confirm in advance
whether or not the used DHCP server software can properly lease an IP address in
response to a network boot (PXE boot).
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This chapter describes how to install DPM.
The items covered in this chapter are as follows:

•
•
•
•
•

2.1
2.2
2.3
2.4
2.5

Installing the DPM Server. ..................................................................................... 14
Installing the DPM Client. ...................................................................................... 32
Installing Image Builder (Remote Console). ........................................................... 39
Installing DPM Command Line............................................................................... 45
Installing PackageDescriber. ................................................................................. 49
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2.1. Installing the DPM Server
The DPM Server manages and performs processing on managed machines based on instructions
from the Web Console or DPM Command Line. When the DPM server is installed, Image Builder and
DPM Command Line are also simultaneously installed.
During DPM Server installation, note the following:
When "DPM Server" is installed via standard installation, "JRE 1.6.0_24", ".NET Framework 3.5
SP1", and "DPM Server" are installed.

•









With Windows Server 2008 R2, install IIS and then install .NET Framework 3.5.1.
Installing .NET Framework 3.5.1 using the add features function of the operating
system (Start -> Administrative Tools -> Server Manager) eliminates the need
to install .NET Framework 3.5 Service Pack 1.
Do not change the Web Site name on IIS from the default value ("Default Web
Site"). If it is modified, return it to "Default Web Site", following the procedure
below.
1) Select Start - Control Panel - Administrative Tools Internet Information Services (IIS) Manager.
2) On the tree view of Internet Information Services (IIS) Manager screen,
select Computer name -> Web Sites, right-click Web Site name,
select Rename, and modified the Web Site name.
If .NET Framework 3.5.1 is already installed, install JRE and the DPM Server by
custom installation. See Section 2.1.2, "Installing the DPM Server by Custom
Installation."
For IIS6.0, confirm that "ASP.NET v2.0.50727" appears when you select Start ->
Administrative Tools -> Internet Information Services (IIS) Manager -> Web
Service Extensions and that the status is "Allowed". If "ASP.NET v2.0.50727"
does not appear, execute the command below to install.
If a different version of ASP.NET is already installed, the setting for the
applications using that ASP.NET may be changed to "v2.0.50727".
%SystemRoot%\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -r
If there is an environment where a different version of ASP.NET coexists, please
use the following steps to confirm that ASP.NET Version is "2.0.50727".







Example)For Windows Server 2003
Administrative Tools -> Internet Information Services (IIS) Manager ->
Web Sites -> Default Web Site -> right click on DPM
From the Properties, ASP.NET tab, the ASP.NET version is "2.0.50727".
For IIS 7.0/7.5, please confirm whether Static Content, ASP.NET and IIS 6
Management Compatibility are installed with Role Service in Web Server
(IIS). Please install the components that are not installed if there is not at least
one installed.
Do a new install of SQL Server 2008 R2 Express even if the environment where
there is an SQL Server installed other than the product bundled with the new
install (SQL Server 2008 R2 Express).
When DPM Server and MasterScope Network Manager are installed on the
same machine, it is necessary to set MasterScope Network Manager's Trivial File
DeploymentManager Ver6.0 Installation Guide
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Transfer Protocol (TFTP) service to cooperate with DPM's TFTP service. Without
setting this, MasterScope Network Manager's TFTP service conflicts with DPM's
TFTP service, and each TFTP service might not work properly. For the setting
method, see Section 10.3, "Notes on Using MasterScope Network Manager" in
the Reference Guide.
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•

Log in to the machine in which the DPM Server is to be installed under Administrator authority, and
verify that the required amount of disk space exists prior to installation.
If you want to save the files in the Folder for Backup Image or Folder for Image of
another machine connected to the network, note the following regarding machines
connected to the network:
•Assign Administrator authority access rights to the Folder for Backup Image and the
Folder for Image for the network.
•It is recommended that you create a user who has Administrator authority other than
the Administrator.





Confirm that Windows Installer 4.5 or later has been installed.
Windows Installer 4.5 is provided on the install media.
[For Windows Server 2008 (x64)]
<Install Media>:\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x64.msu
[For Windows Server 2008 (x86)]
<Install Media>:\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x86.msu
[For Windows Server 2003 (x64)]
<Install Media>:
\dotNet Framework35 SP1\WindowsServer2003-KB942288-v4-x64.exe
[For Windows Server 2003 (x86)]
<Install Media>:
\dotNet Framework35 SP1\WindowsServer2003-KB942288-v4-x86.exe
[For Windows Server 2008 R2]
Installed by default. Installation is not required.
Install and set up IIS in advance. For the installation and setup method, see
Section 1.2.1, "Installing Internet Information Services (IIS)."
When you install the DPM Server, Microsoft SQL Server 2008 R2 Native Client is
also installed. (If Microsoft SQL Server 2008 R2 Native Client is already installed,
SQL Native Client is not overwritten).

・ Verify that a machine with the DPM Server installed does not exist within the network to be
managed by DPM. Existence of such a machine within the same network, even if the versions
are different, results in malfunction. Verify that management is not performed from a DPM Server
located on a network of a different network segment.
It is recommended that you set up the DHCP server in advance before DPM Server
installation.
If you want to use an existing JRE/.NET Framework, see Section 2.1.2, "Installing
the DPM Server by Custom Installation."
・ The data source entitled "DPM" is added to the system where the DPM Server is to be installed.
Do not install the DPM Server on a system where the data source entitled "DPM" is already
installed by an application other than DPM.
・ If there are multiple machines managed by DPM (on a scale of several thousand or more), the
OS may regard connection attempts from the managed machines to the DPM Server as a SYN
flood attack and disconnect communication. If connection from managed machines fails when
multiple machines exist, you may be able to avoid the failure by setting up the following two
registries. (Create the registries if the registries do not exist). After setup, restart the OS.
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Key name:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
Name: SynAttackProtect
Value: DWORD 0 (decimal)
Key name:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
Name: MaxUserPort
Value: DWORD 65534 (decimal)
・ For details of the settings during installation, see Section 2.7, " Basic Information about the
Management Server," in Reference Guide.
・ Depending on the equipment used, you may need to apply a module for equipment support.
Contact your sales or support representative about whether need to apply such a module.
If so, first install the DPM Server, and then apply the module following the procedure provided
with the module for equipment support.
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2.1.1.

Installing the DPM Server by Standard Installation

The following describes how to install the DPM Server by standard installation.
The following procedure is for a DPM unbundled product. Parts of this procedure will
vary from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where DPM is to be installed using a user with Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select DPM Server.

DeploymentManager Ver6.0 Installation Guide
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Selection
of
Installation
Method
(2) The
screen
appears.
Select
Installation(Recommended) and click on the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.

Standard

In an environment in which JRE is already installed, select Custom Installation,
remove the checkmark from JRE, and click on the OK button.
In an environment in which .NET Framework is already installed, select Custom
Installation, remove the checkmark from .NET Framework, and click on the OK
button.

(3) The installation of JRE begins. Wait a while for installation.
(4) The installation of .NET Framework starts. Wait a while for installation.
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(5) The Microsoft .NET Framework 3.5 SP1 Setup screen appears. Check the license contents
and, if you agree, select I have read and ACCEPT the terms of the License Agreement and
click on the Install button.

(6) After installation ends, the following screen appears. Click on the Exit button.
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(7) The Welcome to DeploymentManager Setup (DPM Server) wizard begins. Click on the Next
button.

(8) The License Agreement screen appears. Check the contents and, if you agree, select the Yes
button.
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(9) The Choose Destination Location screen appears. Specify the folder for installation and click
on the Next button.

(10) The Setup Status screen appears and installation begins.

(11) During installation, the DataBase Install screen appears. Select the SQL Server 2008 R2
Express architecture, and click on the OK button.
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This screen will not appear on an x86 operating system.
(12) Next, the Database Install screen appears. Specify the destination folder, and click on the OK
button.

(13) The Detailed Setting screen appears. Select the General tab.

 Specify the IP Address that will be used for the connection with the DPM Client and Image
Builder (Remote Console) in the IP address area of the Server Information box. Select ANY
when you want to enable use of all IP addresses set up in the OS where the DPM Server is to
be operated.
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When the IP Address setting is changed (an IP address change or an
increase/decrease in the number of IP addresses, etc). then please restart
the following services.
•DeploymentManager PXE Management
•DeploymentManager PXE Mtftp
When a value other than ANY is selected as the IP Address and multiple IP
addresses are assigned to a single LAN board, specify the first IP address
that appears on the OS. The DPM may not operate correctly if another IP
address is configured.
When multicast distribution is specified in a restore scenario, specify a value
other than ANY (an IP address set for the used LAN board) as the IP
Address.

 Under Check the completion of a scenario by the communication with DPM Client,
select the method for determining scenario completion. If you want to monitor scenario
completion in real-time, check the option.
When the DHCP server is used, if you check the option, the scenario is complete at the time
of the communication that the scenario ends between the DPM Client and DPM Server. If you
do not check the option, the scenario ends at the last PXE boot of scenario execution. (If
restart has not been specified under remote update, the scenario ends when the application
ends).
When the DHCP server is not used, for example, the scenario will end with the CD boot after
the backup is complete, regardless of whether it is checked or not in the case of a backup.
If you checked the Check the completion of a scenario by the communication
with DPM Client check box, confirm the items below. If these points are not
satisfied, the scenario will not end.
•Be sure to install the DPM Client on the managed machine.
•The network settings must be set so that the machine and DPM Server can
communicate when the scenario ends.
In addition, be sure to check once again whether the managed machine is
included in Section 3.8 First Step Guide, Section 3.8, "Managed Machines
(Physical Machines)," in First Step Guide.





In Upgrade DPM Client automatically, select whether you want to automatically upgrade the
DPM Client.
If you want to automatically upgrade the DPM Client, check the check box.
For automatic upgrades, see Section 3.3.1, "Automatically Upgrading the DPM Client."
If you want to change the backup image storage folder, click on the Browse button next to
Folder for Backup Image in the Image setting group box, and select the folder. The default
is C:\DeployBackup.
If you want to change the image storage folder, click on the Browse button next to Folder for
Image in the Image Setting group box, and select the folder. For the "Folder for Image,"
specify a folder name that stores service packs, applications, and the OS where OS clear
installation is to be performed with DPM. The default is <DPM Server installation
drive>:\Deploy.
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If you change the Folder for Backup Image, change the image file
location of already created backup and restore scenarios and the following
scenarios created by default:
•System_Backup
•System_Restore_Unicast
After the storage locations have been changed, restart the management
server. The management server will not operate normally until it is
restarted.
If you do not change the location of Folder for Backup Image, the backup
image will not appear in the Image List group box.
Folders such as the following cannot be specified as the Folder for
Backup Image or Folder for Image location:
•A folder that serves as both the Folder for Backup Image and Folder for
Image
•The location of Folder for Backup Image or Folder for Image that is
under the other folder (For example: The Folder for Backup Image
cannot be specified as a subfolder under the Folder for Image).
•The Windows system folder
•A folder used by another application
•A folder immediately under a drive
i.e.) "D:\"
•A network drive
Do not change both the Folder for Backup Image and Folder for Image
following a procedure other than that written in this manual (such as by
editing or deleting the folder directly from Explorer). Be sure to change the
folder from here.
Assign access authorization to the Folder for Backup Image and Folder
for Image so that the users who perform DPM operations and the
accounts employed by the various services that start with the name
"DeploymentManager" on the DPM Server [preset value: local system
accounts (SYSTEM)] can access the folders with full control.
Be sure to secure enough free space for both the Folder for Backup
Image and Folder for Image.
For SSC product, the DPM license is included with the SSC product. The
number of licenses is not shown.
You can change the settings after DPM Server installation as well.
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(14) Configure the Scenario tab.



Set the scenario timeout times. Under normal conditions, the settings do not need to be
changed.



The scenario timeout time refers to the timeout time for scenario execution.
If a scenario does not end within the set time for each item, a scenario
execution error occurs.
You can change the settings after DPM Server installation as well.
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(15) Configure the Network tab.



This tab allows you to turn the remote power on and set scenario execution settings. Change
the settings as necessary.




If multicast distribution is specified in a remote update scenario and the
scenario is simultaneously executed on more computers than the number
specified under Machines for Simultaneous Execution, the scenario will be
executed up to the specified number and a scenario execution error will occur
on the remaining machines. If this happens, select the machines on the Web
Console and clear the scenario execution errors. After clearing the errors,
adjust the number specified under Machines for Simultaneous Execution
to an appropriate value, and execute the scenario again on the machines in
which the errors occurred. When a scenario other than a remote update is
executed simultaneously on more computers than the number specified
under Machines for Simultaneous Execution, the scenario is first executed
on the specified number of computers and then the status of the remaining
computers changes to standby. When scenario execution is subsequently
completed on a computer, the next computer in a standby state starts
executing the scenario.
When the power of a managed machine that is waiting for scenario execution
is manually turned on, the scenario is executed, exceeding the number
specified under Machines for Simultaneous Execution.
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Remote Power ON Interval refers to the remote power activation interval
when multiple machines are turned on simultaneously.
Remote Power ON Timeout refers to the amount of time the system should
wait for a response from a machine at power on or during scenario execution.
If a response is not received within the set time, a Remote Power ON error
occurs. The set default value is 10 minutes. Please increase this value if
there is a power on, but a power on error occurs. If you specify 0, the system
waits for a response from the machine. (A Remote Power ON timeout error
does not occur).
Machines for Simultaneous Execution is used to specify the number of
machines that run scenarios simultaneously. The number of devices
available for concurrent control has a maximum value of 1000 devices, but
the load on the network will increase as the number of scenarios concurrently
running increases. The set default value is 5. If you want to run more than 5
simultaneously, change the setting.
You can change the settings after DPM Server installation as well.

(16) Configure the DHCP Server tab and click the OK button.

 Confirm the DHCP server installation location. If you are using the DHCP service installed on
the DPM server, select the DHCP Server is installed on the machine (selected by default).
If you want to use a DHCP server on a different computer, select DHCP Server is installed
on an another machine.
If you do not want to install a DHCP server, select Do Not Use A DHCP Server.
If you want to use a DHCP service constructed on the DPM server, do not install
another DHCP server on the same network. If you want to use a DHCP server
constructed on another machine, you can have multiple DHCP servers exist on
the same network.
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You can change the settings after DPM Server installation as well.
(17) The InstallShield Wizard Complete screen appears. Click on the Finish button.




Once installation is complete, DeploymentManager is registered in the
Start menu.
When either of the services below is running, the port required for the DPM
Server will open automatically. (For details on the opened port, see Appendix
D, "Network Port and Protocol List," in Reference Guide).
•Windows Firewall/Internet Connection Sharing(ICS)
•Windows Firewall

The DPM Server is now installed based on standard installation.
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2.1.2.

Installing the DPM Server by Custom Installation

The following describes how to custom-install the DPM Server.
If .NET Framework 3.5 SP1 or the DPM recommended JRE 6 Update 24 has already
been installed, install required components using custom installation. Use of a
version of JRE that is not recommended may cause DPM to not function properly.
The procedure below is for a DPM unbundled product. Parts of this procedure will
vary from those for SSC product. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where DPM Server is to be installed using a user with Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select DPM Server.
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(2) The Selection of Installation Method screen is displayed. Select Custom Installation and then
check the items to install and click on the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.

The messages displayed after this point differ according to the items you have selected. (The
checked items will be installed in their listed order). For further details, see Section 2.1.1,
"Installing the DPM Server by Standard Installation."
The DPM Server is now installed based on custom installation.
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2.2. Installing the DPM Client
The DPM Client exchanges data with the DPM Server and controls the operation of managed
machines.
The installation method varies according to the OS of the managed machine. If you are using
Windows, see Section 2.2.1, "Installing the Windows (IA32/EM64T) Version." If you are using Linux,
see Section 2.2.2, "Installing the Linux (IA32/EM64T) Version."
During DPM client installation, note the following:
・ For information on operating systems that permit installation, see Section 3.8, "Managed
Machines (Physical Machines)," in First Step Guide.
・ Log in to the machine in which the DPM Client is to be installed under Administrator authority,
and verify that the required disk space exists prior to installation.
・ On machines that Linux OS is installed by clear installation, the DPM Client was installed
simultaneously with OS installation. There is no need to install it separately.
Always use a DPM Client that is of the same version/revision as the DPM Server. If
you are using an older version/revision of a DPM Client, see Section 3.3, "Upgrading
the DPM Client" and upgrade the client.
Be sure to install the DPM Client if you had selected Check the completion of a
scenario by the communication with DPM Client under Management view ->
DPM Server -> Detail Setting -> General tab. Failure to do so causes the system to
not recognize scenario completion, resulting in a scenario error.
While DPM Client installation is not required, the following functions cannot be used
without client installation:
•Installation of Service Pack/HotFix/Linux patch file
•Installation of Application
•Shutdown
•Transmission of OS, service pack, HotFix, and Linux patch file information to DPM
Server
•Forced execution of restart during scenario execution
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2.2.1.

Installing the Windows (IA32/EM64T) Version

This section describes how to install the DPM Client (Windows).
The procedure below is for a DPM unbundled product. Parts of this procedure will
vary from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where DPM Client is to be installed using a user with Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select DPM Client.

If you want to install the DPM Client on Windows Server 2008 (Server Core
installation), execute the files below to display the DeploymentManager Setup
screen.
•For products for SSC: <Install media>:\DPM\Launch.exe
•For DPM unbundled product: <Install media>:\Launch.exe
(2) The Confirmation screen appears. Click on the Yes button.
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(3) The Enter IP Address screen appears. Enter the IP address of the management server where
the DPM Server was installed, and click on the Next button.

(4) After automatic processing, the InstallShield Wizard Complete screen appears. Click on the
Finish button.
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Programs and Features displays the capacity of the folder in which the application
was installed. The DPM Client displays a larger capacity than the actual capacity
since it is installed under the system folder.

 If either the Windows Firewall Service or Windows Firewall/Internet Connection
Sharing (ICS) Service is started, the port required by the DPM client will
automatically be opened.
Protocol
ICMP
TCP
UDP
TCP
TCP

Port Number
8 (Echo incoming)
56000
56001
56010
56025

 After installing the DPM client in Windows Server 2008 (excluding Server Core
installation) /Windows Vista/Windows 7, the following message may be outputted
to the event log. This message, however, is unproblematic in terms of operation.
•The DeploymentManager Agent service is marked as an interactive service.
However, the system is configured to not allow interactive services. Therefore,
this service may not function properly.
•The DeploymentManager Remote Update Service Client service is marked as
an interactive service. However, the system is configured to not allow interactive
services. Therefore, this service may not function properly.
The DPM Client (Windows) is now installed.

2.2.2.

Installing the Linux (IA32/EM64T) Version

This section describes how to install the DPM Client (Linux).
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 The following libraries are needed for the DPM client to run.
•libpthread.so.0
•libc.so.* (*1)
•ld-linux.so.2
•glibc (*2)
*1
* Indicates a numeric value.
*2
Please be careful if the ignore package dependencies option (--nodeps) is set at
the time of installation, because the necessary packages might not be installed.
In addition to the above, the following packages need to be installed if the
managed machine is EM64T. However, these need not be installed if Compatibility
libraries (libraries to operate IA32 modules on an EM64T OS environment) are
installed.
•glibc-*-*.i686.rpm (*1, *2)
*1
* Indicates a numeric value. (Version/release number)
*2
Please be careful if the ignore package dependencies option (--nodeps) is set at
the time of installation, because the necessary packages might not be installed.
 The following libraries are required to perform OS installation by disk duplication.
•linux-gate.so.*
•libc.so.*
•ld-linux.so.*
•libcrypt.so.*
•libfreebl3.so
*Indicates a numeric value.
In addition to the above, the following packages are required if the managed
machine is EM64T. However, these need not be installed if Compatibility libraries
(libraries to operate IA32 modules on an EM64T OS environment) are installed.
•glibc-*-*.i686.rpm (*)
･nss-softokn-freebl-*-*.i686.rpm (*)
*Indicates a numeric value. (Version/release number)
*Please be careful if the ignore package dependencies option (--nodeps) is set at
the time of installation, because the necessary packages might not be installed.
 The following libraries are required for a managed machine that is EM64T to
perform a remote update using multi-cast.
•/lib/libgcc_s.so.1
This library is separately required even if a library with the same name exists
under "/lib/x64". Please install the following rpm package for the libraries. If you
want to install this rpm using remote update, execute distribution by unicast.
•libgcc-3.4.5-2.i386.rpm
 In order to install DPM client on a managed machine that already has Linux OS
installed, please open the following ports that the DPM client will use.
Protocol
TCP
UDP
TCP

Port Number
56000
56001
56010
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(1) Using a root account, log in to the machine on which the DPM Client is to be installed.
(2) Insert the install media into the DVD drive.
(3) Mount the install media.
# mount /mnt/dvd



In the case of Red Hat Enterprise Linux AS4/ES4 and SUSE Linux Enterprise 9,
switch "/mnt" with "/media" and continue to operate.
For SUSE Linux Enterprise 10/11, proceed with the uninstall while reading
"/mnt/dvd" as "/media/<install media volume label>" below.

(4) Enter the following command to change the current directory.
•For SSC product: # cd /mnt/dvd/DPM/Linux/ia32/bin/agent
•For DPM unbundled product: # cd /mnt/dvd/Linux/ia32/bin/agent
(5) Execute depinst.sh.
#./depinst.sh
Depending on the execution environment, you may not have the authority to run
depinst.sh on the install media.
In this case, copy the DPM client module in the Linux directory on the DVD to the
correct directory on the hard disk, then run a chmod command like in the example
below to grant authority for all of the files and then run depinst.sh.
Example)
# cd/mnt/copy destination directory/agent
# chmod 755 *
*The save location for the DPM client installer is as below.
•For SSC product: <Install media>:/DPM/Linux/ia32/bin/agent
•For DPM unbundled product: < Install media >:/Linux/ia32/bin/agent
(6) The input request for the IP address of the management server is outputted.
Enter the IP address of the management server.
>
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(7) Enter the IP address of the management server and press the Enter key.
The DPM Client (Linux) is now installed.
If unzip is not installed, the following message appears on the console. Please install
unzip.
The unzip command is required in order to support remote update.
Please install a unzip package.
The unzip package is attached to installation CD of Linux OS.
Installation of client service was completed.







You do not need to restart the system.
If Linux is running on an X window system and the DPM Client (Linux) is
installed, the console automatically opens at log-in in order to show messages
of shutdown from the DPM Server or the remote updates performed. If you exit
the console, you cannot see the messages. If you accidently exit the console,
open the console again.
Note that when the system is running in txt mode, these messages are
outputted to the active screen. txt mode will not impact DPM operation.
When you install the DPM Client, the following message may appear:
Warning: This program is an suid-root program or is being run by the root user.
The full text of the error or warning message cannot be safely formatted in this
environment. You may get a more descriptive message by running the program
as a non-root user or by removing the suid bit on the executable.
/usr/X11R6/bin/xterm Xt error: Can't open display:%s
This message appears under one of the following conditions:
•The DPM Client was installed without X server installed on the managed
machine.
•X server is installed on the managed machine, but was not running when you
installed the DPM Client.
•You installed the DPM Client after logging into the managed machine using a
root user account from telnet.
This happens because DPM Client related messages cannot be displayed.
There is no impact on actual operation.
With SUSE Linux Enterprise, the console for showing messages outputted by
the Linux agent client service does not automatically open at X-Window startup.
If you need to open the console, edit the X-Window startup script following the
procedure below:
1) Open the /etc/X11/xinit/xinitrc file using an editor such as vi.
2) Insert the following lines under the line #Add your own lines here . . .: *
# Console for client service
if [ -x /etc/X11/xinit/xdpmmsg.sh ] ; then
/etc/X11/xinit/xdpmmsg.sh
fi
3) Save the file and close the editor.
4) Restart the machine or X-Window.
*If the line #Add your own lines here . . . does not exist, insert the line
before the exec $WINDOWSMANAGER line.
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2.3. Installing Image Builder (Remote
Console)
Image Builder is a tool for creating package, disk duplication data files etc, and registering the created
files to the management server.
Image Builder is simultaneously installed when you install the DPM Server, and therefore does not
need to be separately installed when used on the same machine as the DPM Server.
Image Builder installation is required when used on a machine other than the DPM Server machine. In
this case, Image Builder is referred to as Image Builder (Remote Console).
Note the following precautions when installing Image Builder (Remote Console):
・ For information on the operating systems that permit installation, see Section 3.4, "Image
Builder (Remote Console)," in First Step Guide.
・ Verify that the disk space required to install Image Builder (Remote Console) exists.
Additional disk space is required for JRE installation. (The required disk space varies
depending on the JRE version).
If you want to use an existing JRE, see Section 2.3.2, "Installing Image Builder
(Remote Console) by Custom Installation."

2.3.1.

Installing Image Builder (Remote Console) by Standard
Installation

The following describes how to install Image Builder (Remote Console) by standard installation.
The procedure below is for a DPM unbundled product. Parts of this procedure will vary
from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where Image Builder (Remote Console) is to be installed using a user with
Administrator authority.
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(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select Image Builder(Remote Console).

Selection
of
Installation
Method
(2) The
screen
appears.
Select
Installation(Recommended) and click on the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.

Standard

In an environment where JRE is already installed, select Custom Installation,
remove the checkmark from JRE, and click on the OK button.

The dialog is shown when JRE is already installed.
•Click on the YES button to overwrite the existing JRE.
•Click on the Cancel button to return to the DeploymentManager Setup screen.
(3) The installation of JRE begins. Wait a while for installation.
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(4) The Welcome to DeploymentManager (ImageBuilder) Setup wizard begins. Click on the Next
button.

(5) The Choose Destination Location screen appears. Specify the folder for installation and click on
the Next button.
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(6) The Setup Status screen appears and installation begins.

(7) Installation ends, and the InstallShield Wizard Complete screen appears. Click on the Finish
button.

Once installation is complete, DeploymentManager is registered in the Start
menu.
Image Builder (Remote Console) is now installed based on standard installation.
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2.3.2.

Installing Image Builder (Remote Console) by Custom
Installation

The following describes how to install Image Builder (Remote Console) by custom installation.
If you custom-install Image Builder(Remote console) using a combination of settings
other than those recommended, Image Builder(Remote console) may not operate
properly.
The procedure below is for a DPM unbundled product. Parts of this procedure will
vary from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where Image Builder (Remote Console) is to be installed using a user with
Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select Image Builder(Remote Console).
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(2) The Select Installation Method screen is displayed. Select Custom Install and then check the
items to install and click on the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.

(3) The messages displayed after this point differ according to the items you have selected. (The
checked items will be installed in their listed order). For further details, see Section 2.3.1,
"Installing Image Builder (Remote Control) by Standard Installation."
Image Builder (Remote Console) is now custom-installed.
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2.4. Installing DPM Command Line
DPM Command Line is a command line interface used to execute processing on managed machines
and check the execution status.
DPM Command Line is simultaneously installed when you install the DPM Server, and therefore does
not need to be separately installed when used on the same machine as the DPM Server. Installation
of DPM Command Line is required when used on a machine other than the DPM Server machine.
During DPM Command Line installation, note the following:
・ For information on operating systems that permit installation, refer to Section 3.5, "DPM
Command Line," in First Step Guide.
・ Verify that the disk space required to install DPM Command Line exists.
Confirm that Windows Installer 4.5 or later has been installed.
Windows Installer 4.5 is provided on the install media.
[For Windows Server 2008(x64)]
<Install Media>:
\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x64.msu
[For Windows Server 2008(x86)]
<Install Media>:
\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x86.msu
[For Windows Server 2003(x64)]
<Install Media>:
\dotNet Framework35 SP1\WindowsServer2003-KB942288-v4-x64.exe
[For Windows Server 2003(x86)]
<Install Media>:
\dotNet Framework35 SP1\WindowsServer2003-KB942288-v4-x86.exe
[For Windows Server 2008 R2]
Installed by default. Installation is not required.
The following describes how to install DPM Command Line.
The procedure below is for a DPM unbundled product. Parts of this procedure will
vary from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where DPM Command Line is to be installed using a user with Administrator
authority.

Part I DeploymentManager Installation Process
45

2 Installing DPM

(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select DPM Command Line.

(2) The Confirmation screen appears. Click on the Yes button.

DeploymentManager Ver6.0 Installation Guide
46

Installing DPM Command Line

(3) The Welcome to DeploymentManager (DPM Command Line) Setup wizard begins. Click on
the Next button.

(4) The Choose Destination Location screen appears. Specify the folder for installation and click on
the Next button.

Be sure to remember the folder that you specified for installation. To use DPM
Command Line, move to the installation destination from the command prompt. The
default installation folder is:
(System Drive):\Program Files\NEC\DeploymentManager.
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(5) The Setup Status screen appears and installation begins.

(6) Installation ends, and the InstallShield Wizard Complete screen appears. Click on the Finish
button.

DPM Command Line is now installed.
For details on how to use DPM Command Line, see Section 8, "Command
Reference," in the Reference Guide.
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2.5. Installing PackageDescriber
PackageDescriber is a tool used to create and register packages to the Package Web Server.
During PackageDescriber installation, note the following:
・ For information on operating systems that permit installation, see Section 3.7,
"PackageDescriber," in First Step Guide.
・ Verify that the disk space required to install PackageDescriber exists.
The procedure below is for a DPM unbundled product. Parts of this procedure will vary
from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.

2.5.1.

Installing PackageDescriber by Standard Installation

Log in to the machine where PackageDescriber is to be installed using a user with Administrator
authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select PackageDescriber.

If you want to install PackageDescriber in an environment where UAC is enabled on
Windows Vista, be sure to follow the procedure below.
1) On the DeploymentManager Setup Screen, click on the Exit button.
2) Using Explorer, etc., right-click on the following files and select Run as
Administrator.
•For SSC product:(Installation DVD):\DPM\Launch.exe
•For DPM unbundled product:<Install Media>:\Launch.exe
3) The DeploymentManager Setup screen appears again. Select
PackageDescriber.
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(2) The Selection of Installation Method screen appears. Select Standard Installation -> click on
the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.
If JRE is already installed (when performing installation on the same machine as the
DPM Server, etc.), select Custom Installation, remove the checkmark from JRE,
and click on the OK button. The following describes the method for Standard
Installation.

(3) The installation of JRE begins. Wait a while for installation.
(4) Next, the PackageDescriber Installer begins. The Welcome to DPM PackageDescriber Setup
screen appears. Click on the Next button.
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(5) The Customer Information screen appears. Enter the User Name and Company Name, and
click on the Next button.

(6) The Choose Destination Location screen appears. Specify the folder for installation and click
on the Next button.
The default setting is (System drive):\Program Files\NEC\PackageDescriberDPM. Click on the
Change button to change the setting.
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(7) The Ready to Install the Program screen appears. Click on the Install button.

(8) The Setup Status screen appears and installation begins.
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(9) Installation ends, and the InstallShield Wizard Complete screen appears. Click on the Finish
button.

PackageDescriber is now installed.
Once installation is completed, a shortcut is added to the Start menu.

2.5.2.

Installing PackageDescriber by Custom Installation

The following describes how to custom-install PackageDescriber.
If you custom-install PackageDescriber using a combination of settings other than
those recommended, PackageDescriber may not operate properly.
The procedure below is for a DPM unbundled product. Parts of this procedure will
vary from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
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(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select PackageDescriber.

(2) The Selection of Installation Method screen appears. Check Custom Installation and click on
the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.

(3) The messages displayed after this point differ according to the items you have selected. (The
checked items will be installed in their listed order). For further details, see Section 2.5.1,
"Installing PackageDescriber by Standard Installation."
PackageDescriber is now custom-installed.
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Upgrading DPM

This chapter describes how to upgrade the environment in which your current DPM is installed to
DPM Ver6.0.
The items covered in this chapter are as follows:

•
•
•
•
•
•
•

3.1
3.2
3.3
3.4
3.5
3.6
3.7

Before Upgrading DPM.......................................................................................... 56
Upgrading the DPM Server. ................................................................................... 58
Upgrading the DPM Client. .................................................................................... 66
Upgrade install of Image Builder (Remote Console). .............................................. 72
Upgrading DPM Command Line. ........................................................................... 76
Upgrading PackageDescriber. ............................................................................... 79
Precautions: Upgrading from DPM Ver4.0/4.1/4.2/4.3. ........................................... 82
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3.1. Before Upgrading DPM
3.1.1.

Upgrading Precautions

The following describes how to upgrade each function of DPM. Before starting the upgrade process,
finish DPM related tasks. If Event Viewer is running, close Event Viewer as well.












This system supports the following upgrades only:
•From a Standard Edition product of DPM Ver4.0 or later to a DPM unbundled
product of this current version
•From a Enterprise Edition product of DPM Ver4.0 or later to a DPM unbundled
product of this current version
•From a SSC product of SSC 1.1 (DPM Ver4.1 or later) to a SSC product of this
current version
If you want to install a SSC product or DPM unbundled product of this current
version after installing VirtualPCCenter VH of DPM Ver5.0 or earlier, first uninstall
the VirtualPCCenter VH and then install the DPM unbundled product.
If you want to upgrade a DPM unbundled product from an older version, you need
to register the license key for this current version after upgrading. If you do not
register the license key, you cannot use DPM.
If you have a PP support service agreement, you can upgrade the version in
accordance with the media license free-of-charge. Apply for a version upgrade
through the PP support service.
You can use your license key as is for revision upgrades (when the upgrade is for
a DPM version of x.y with a different y only).
For license registration details, see Section 5.1.4, "Registering the License Key."
(For SSC products, see the SigmaSystemCenter Installation Guide).
Management Server for DPM, Web Server for DPM and Database which prior to
DPM6.0 are integrated into the DPM server in DPM Ver6.0. The data for the old
version of each component will be handled as follows at the time of upgrade.
・ The management server for DPM data will be inherited at the time of upgrade.
・ If you are using DPM Ver5.0 or higher, the SQL server and DPM database
(instance) are installed. In this case, the DPM database (instance) can be
inherited and used as is when upgraded.
・ Web server for DPM (DPM data used by Tomcat) is removed when upgrading
the DPM Server to DPM Ver6.0 because it is not used any more.
DPM Ver6.0 and later does not use Tomcat which was used in versions earlier
than DPM Ver6.0. Uninstall Tomcat as necessary. For the uninstallation method,
refer to the user´s guide of the version you used.
[DPM Ver4.21 or earlier]
<Install Media>:\DPM\TOOLS\TomcatUninstall\Tomcat_Silent_Uninst_41.bat
Execute \DPM\TOOLS\TomcatUninstall\Tomcat_Silent_Uninst_41.bat
[DPM Ver4.3x or later]
<Install Media>:\DPM\TOOLS\TomcatUninstall\Tomcat_Silent_Uninst_55.bat
Execute \DPM\TOOLS\TomcatUninstall\Tomcat_Silent_Uninst_55.bat
[DPM Ver5.x or later]
<Install Media>:\DPM\TOOLS\TomcatUninstall\Tomcat_Silent_Uninst_60.bat
Execute \DPM\TOOLS\TomcatUninstall\Tomcat_Silent_Uninst_60.bat
The upgrade installation which DPM Ver5.x management server for DPM and the
database configured with different machines is not supported. Also, for
management server for DPM and Web server for DPM configured with different
machines, please perform an upgrade installation of the DPM server on the
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machine that has installed management server for DPM. Web server for DPM
does not use, so please uninstall it. Uninstall Tomcat itself if necessary.
Before upgrading, verify version support by referring to Appendix A, "Support
Table," in First Step Guide.




You cannot perform upgrades from Programs and Features.
Perform upgrades from the install media.
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3.2. Upgrading the DPM Server
The following describes how to upgrade the DPM Server.
Perform the upgrade process on the machine in which the DPM Server (Management Server for DPM
on versions earlier than DPM Ver6.0) is installed.
The upgrade procedure varies depending on the version.










If upgrade installing from DPM Ver4.0/4.1/4.2/4.3, please stop all services
(services starting with the name "DeploymentManager") related to DPM. (If the
services do not stop, close the processes using Windows Task Manager).
If Tomcat is installed, stop the "Apache Tomcat" service.
Confirm that Windows Installer 4.5 or later has been installed.
Windows Installer 4.5 is provided on the install media.
[For Windows Server 2008 (x64)]
<Install Media>:\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x64.msu
[For Windows Server 2008 (x86)]
<Install Media>:\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x86.msu
[For Windows Server 2003 (x64)]
<Install Media>:
\dotNet Framework35 SP1\WindowsServer2003-KB942288-v4-x64.exe
[For Windows Server 2003 (x86)]
<Install Media>:
\dotNet Framework35 SP1\WindowsServer2003-KB942288-v4-x86.exe
[For Windows Server 2008 R2]
Installed by default. Installation is not required.
If you want to upgrade from a version earlier than DPM Ver6.0, you will need to
install and set up IIS. See Section 1.2.1, "Installing Internet Information Services
(IIS)."
Do not change the Web Site name on IIS from the default value ("Default Web
Site"). If it is modified, return it to "Default Web Site", following the procedure
below.
1) Select Start - Control Panel - Administrative Tools Internet Information Services (IIS) Manager.
2) On the tree view of Internet Information Services (IIS) Manager screen,
select Computer name -> Web Sites, right-click Web Site name, select
Rename, and modified the Web Site name.
For IIS6.0, confirm that "ASP.NET v2.0.50727" appears when you select Start ->
Administrative Tools -> Internet Information Services (IIS) Manager -> Web
Service Extensions and that the status is "Allowed". If "ASP.NET v2.0.50727"
does not appear, execute the command below to install.
If a different version of ASP.NET is already installed, the setting for the
applications using that ASP.NET may be changed to "v2.0.50727".
%SystemRoot%\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -r
If there is an environment where a different version of ASP.NET coexists, please
use the following steps to confirm that ASP.NET Version is "2.0.50727".
Example) For Windows Server 2003
Administrative Tools -> Internet Information Services (IIS) Manager -> Web
Site -> Default Web Site -> right click on DPM
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From the Properties, ASP.NET tab, the ASP.NET version is "2.0.50727".
For backup image files created by DPM with a version earlier than DPM Ver6.0,
note the following:
•DPM Ver6.0 does not automatically move the files to the Folder for Backup
Image set up on the Web Console. Manually move the files to the backup image
storage folder.
•If a backup image file is located in the Folder for Backup Image, the backup
image file appears as an image on the Image List screen of the Web Console,
but the information related to the image does not. To display the related
information, you will need to execute backup once again.
The OS clear installation function of Windows OS can´t be used from DPM
Ver6.0. If you used the OS clear installation function with a version prior to DPM
Ver6.0, perform the following prior to upgrading.
•Please delete scenarios that include Windows OS clear installation from the Web
console.
•Please delete the OS image used for OS clear installation (Windows) from Image
Builder -> Delete registered data -> Operating system.
The procedure below is for a DPM unbundled product. Parts of this procedure will
vary from those for SSC products. For SSC product, see the SigmaSystemCenter
Installation Guide as well.
Be sure to remove in advance the service packs, HotFixes, and applications that
you do not plan on using this version.
About the database configuration steps for each product of the SQL Server, please
contact your sales or support representative about it.
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Log in to the machine to be upgraded using a user of Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select DPM Server.
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(2) The Selection of Installation Method screen appears. Select Standard Installation, and click
on the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.



In an environment where JRE is already installed, select Custom Installation,
remove the checkmark from JRE, and click on the OK button.
In an environment in which .NET Framework is already installed, select
Custom Installation, remove the checkmark from .NET Framework, and click
OK button.

If you want to upgrade the DPM Server on Windows Server 2008, select Custom
Installation, remove the checkmark from .Net Framework, click on the OK button,
and proceed to Step (8).
(3) The messages displayed after this point differ according to the items you have selected. (The
checked items will be installed in their listed order). The following describes how to execute a
standard upgrade.
(4) The Confirmation screen appears. Click on the Yes button.

(5) The installation of JRE begins. Wait a while for installation.
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(6) The following screen appears. Select Repair and click on the Next button.
(Remove the checkmark from the Send information about my setup experiences to Microsoft
Corporation check box if you do not agree with the data collection policy).

(7) Installation begins. Once installation ends, the following screen appears. Click on the Exit button.

DeploymentManager Ver6.0 Installation Guide
62

Upgrading the DPM Server




If a screen prompting you to restart the machine appears after you click on the
Exit button, restart the machine following the instructions on the screen.
If you restart the machine, follow Steps (1) to (5), click on the Cancel button in
Step (6), and then proceed to Step (8).

(8) The Setup Type screen appears. Check Overwrite Install and click on the Next button.

(9) A confirmation screen appears. Click on the OK button.
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(10) The Setup Status screen appears and installation begins.

(11) The following screen appears and installation begins. Wait a moment.

(12) The IIS confirmation screen appears. Click on the Yes button.
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(13) The following screen appears. Click on the OK button.

(14) The Maintenance Complete screen appears. Click on the Finish button.

If you have set the cooperation between DPM's TFTP service and MasterScope
Network Manager's TFTP service, you need to configure it again after upgrading the
DPM Server. For the setting method, see Section 10.3, "Notes on Using
MasterScope Network Manager" in the Reference Guide.

The screens that appear during installation vary according to the OS.

If the Windows Firewall/Internet Connection Sharing (ICS) service is running, the
port required for the DPM Server will open automatically.
For details on the opened port, see Appendix D, "Network Port and Protocol List," in
Reference Guide.
The DPM Server is now upgraded.
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3.3. Upgrading the DPM Client
The following describes how to upgrade the DPM Client.
Perform the upgrade process on the machine in which the DPM Client (Client Service for DPM on
versions earlier than DPM Ver6.0) is installed.
The following lists the DPM versions subject to upgrade:
-DPM Ver4.0/4.1/4.2/4.3/5.0/5.1/5.2
This system supports an automatic upgrade method in which the DPM Client is automatically
upgraded when you update the DPM Server. For details, see Section 3.3.1, "Automatically Upgrading
the DPM Client."
Other methods for upgrading the DPM Client include upgrading from a scenario and upgrading from
the install media. For procedure details, see Section 3.3.2, "Manually Upgrading the DPM Client."

3.3.1.

Automatically Upgrading the DPM Client

What is Automatic DPM Client Upgrade?
Automatic DPM Client Upgrade is a function that automatically upgrades the DPM Client(Client
Service for DPM in versions earlier than DPM Ver.6.0) when you upgrade the DPM Server. This
function is a great convenience to reinstalling the DPM Client of this current version one by one.
The automatic upgrade is implemented when the machine with the installed DPM Client is started. At
machine startup, the DPM Client starts up and communicates with the DPM Server. If the DPM Client
version/revision differs from that of the DPM Server, the version/revision will be automatically
upgraded.







If you do not upgrade the DPM Client, scenarios about service packs, HotFixes,
Linux patch files, and applications may not work properly. Be sure to upgrade the
DPM Client to the same version/revision as the DPM Server.
The system automatically upgrades the DPM Client only when Upgrade DPM
Client automatically is checked on the General tab found by selecting
Management view on the Web Console and clicking DPM Server -> Detail
Setting.
If you run a DPM client automatic upgrade, the System_AgentUpgrade_Unicast,
System_LinuxAgentUpgrade_Unicast, or System_WinCEAgentUpgrade_Unicast
scenarios managed internally by DPM will be automatically assigned. If another
scenario was previously assigned, that scenario is released.
The automatic upgrade scenario remains assigned as is after execution. If the
released scenario specified a schedule is needed, be sure to reassign it after the
automatic upgrade.
Note that an automatic upgrade scenario cannot be executed manually.
If the DPM Client was automatically upgraded on a Linux client, do not execute
another scenario for a period of about two minutes after the scenario starts.
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If the managed machine was started by scenario execution from a power
OFF state, automatic upgrade is not performed.
Automatic upgrade is treated as scenario execution, and thus the execution
results appear on the Scenario Execution Result List screen.
The automatic upgrade is treated as scenario execution, and thus scenario
cancellation is possible. However, the execution time is extremely short,
making cancellation impossible.
After automatic upgrade execution, the DPM Client is restarted after ten to
twenty seconds. If you execute another scenario during this scenario, a
scenario execution error may occur.
This procedure is for upgrading the DPM Client to the current version. The
procedure cannot be used to newly install the DPM Client on a managed
machine in which the DPM Client is not installed.
While the following log may be outputted to the event log of the managed
machine, operation will be unproblematic.
•DepAgent: Accept error code=10004
During automatic upgrade, you cannot display the Scenario Execution List
screen.
The following log is sometimes outputted to the event log of the DPM Server:
depssvc: Agent Upgrade Error MAC : Sts = (MAC address)
This log means that, for some reason, the attempt to automatically install the
DPM Client on the displayed managed machine failed.
If this happens, execute the scenario for upgrading the DPM Client.
If the following appears, the DPM Client upgrade was successful.
Example)
•Windows Server 2003: The version under support information for
DeploymentManager in Add or Remove Programs appears as
"6.00.xxx".
•Windows Server 2008: The version under version for
DeploymentManager in Programs and Features appears as "6.00.xxx".
When either of the services below is running, the port required for the DPM
client will open automatically. (For details on the opened port, see Appendix
D, "Network Port and Protocol List," in Reference Guide).
•Windows Firewall/Internet Connection Sharing (ICS)
•Windows Firewall
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3.3.2.


Manually Upgrading the DPM Client

Upgrading the DPM Client from a Scenario

What Does It Mean to Upgrade the DPM Client from a Scenario?
Aside from the automatic DPM Client upgrade, a scenario for upgrading the DPM Client (Client
Service for DPM in versions earlier than DPM Ver6.0) is registered in the system in advance. You can
upgrade the DPM Client by executing this scenario.

*System_AgentUpgrade_Multicast is the upgrade scenario for Windows (IA32/EM64T).
(NEC US110 is excluded).
System_LinuxAgentUpgrade_Multicast is the upgrade scenario for Linux (IA32).
System_WinCEAgentUpgrade_Multicast is the upgrade scenario for (ARMv4i) NEC US110.




Change the Maximum Targets and Maximum Waiting Time in accordance with
the environment used.
Note that, if you change any item other than the above, the DPM Client may not be
upgraded. In particular, be sure to specify the Execution Time Setting as Excute
Immediately After Distribution.
The DPM Client is upgraded after the upgrade scenario ends. Normally, this
processing will take about tens of seconds. During this period, do not execute
another scenario.
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DPM Client upgrade by install media

・ Windows(IA32/EM64T)
The following describes how to upgrade the DPM Client from the install media [Windows
(IA32/EM64T)].
(NEC US110 is excluded).
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter Installation
Guide as well.
Log in to the machine to be upgraded by user with Administrator authority.
(1) Insert the install media into the DVD drive.
If the Installer starts, click on the Exit button to close the screen.
(2) From Explorer, etc., execute the following files located on the install media.
For SSC product: <Install media>:\DPM\TOOLS\SERVICES\IA32\setup.exe
For DPM unbundled product: <Install media>:\TOOLS\SERVICES\IA32\setup.exe
You can install the DPM Client by copying the contents of the folders located on the
install media to the machine and executing setup.exe.
•For SSC product: (Install media):\DPM\TOOLS\SERVICES\IA32 folder
•For DPM unbundled product:<Install Media>:\TOOLS\SERVICES\IA32 folder
(3) The Setup Type screen appears. Check Overwrite Install and click on the Next button.

Part I DeploymentManager Installation Process
69

3 Upgrading DPM

(4) A confirmation screen appears. Click on the OK button.

(5) The Enter IP Address screen appears. Enter the IP address of the management server where
the DPM Server is installed, and click on the Next button.
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(6) Overwrite installation begins and the InstallShield Wizard Complete screen appears. Click on
the Finish button.




The screens that appear during installation may vary somewhat, depending on
the OS.
In Programs and Features displays the capacity of the folder in which the
application was installed. The DPM Client displays a larger capacity than the
actual capacity since it is installed under the system folder.

See Appendix A, "Silent Installation" to execute silent installation, which does not
require you to enter the IP address of the management server or to perform key
operations during installation.
If either of the services below is running, the port required for the DPM Client will be
opened automatically.
(For details on the opened port, see Appendix D, "Network Port and Protocol List," in
Reference Guide).
•Windows Server 2003: Windows Firewall/Internet Connection Sharing(ICS)
•Windows Server 2008: Windows Firewall
The DPM Client (IA32/EM64T) is now upgraded.
•Linux
The method used to upgrade the DPM Client (Linux) from the install media is the same as that for a
new installation. See Section 2.2.2, "Installing Linux (IA32/EM64T)."
•NEC US110
NEC US110 cannot be upgraded from the install media. If an upgrade installation is necessary, the
automatic upgrade function of the DPM Client automatically performs an upgrade.
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3.4. Upgrade install of Image Builder (Remote
Console)
The following describes how to upgrade Image Builder (Remote Console).
The procedure below is for a DPM unbundled product. Parts of this procedure will vary
from those for SSC products. For SSC products, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine to be upgraded by user with Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select Image Builder(Remote Console).
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(2) The Selection of Installation Method screen appears. Select Standard Installation, and click
on the OK button. Clicking Cancel returns the screen to the DeploymentManager Setup
screen.
In an environment where JRE is already installed, select Custom Installation,
remove the checkmark from JRE, and click on the OK button.

(3) The Confirmation screen appears. Click on the Yes button.

(4) The installation of JRE begins. Wait a while for installation.
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(5) The Setup Type screen appears. Check Overwrite Install and click on the Next button.

(6) A confirmation screen appears. Click on the OK button
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(7) Overwriting begins.

(8) The Maintenance Complete screen appears. Click on the Finish button.

Image Builder (Remote Console) is now upgraded.
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3.5. Upgrading DPM Command Line
The following describes how to upgrade DPM Command Line.
Perform the upgrade process on the machine in which DPM Command Line (Command Line for DPM
on versions earlier than DPM Ver6.0) is installed.
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter Installation
Guide as well.
Confirm that Windows Installer 4.5 or later has been installed.
Windows Installer 4.5 is provided on the install media.
[For Windows Server 2008 (x64)]
<Install Media>:\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x64.msu
[For Windows Server 2008 (x86)]
<Install Media>:\dotNet Framework35 SP1\Windows6.0-KB942288-v2-x86.msu
[For Windows Server 2003 (x64)]
<Install Media>:\dotNet Framework35 SP1\
WindowsServer2003-KB942288-v4-x64.exe
[For Windows Server 2003 (x86)]
<Install Media>:\dotNet Framework35 SP1\
WindowsServer2003-KB942288-v4-x86.exe
[For Windows Server 2008 R2]
Installed by default. Installation is not required.
Log in to the machine to be upgraded by user with Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select DPM Command Line.
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(2) The Confirmation screen appears. Click on the Yes button.

(3) The Setup Type screen appears. Check Overwrite Install and click on the Next button.

(4) A confirmation screen appears. Click on the OK button.
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(5) Overwrite installation begins and the Maintenance Complete screen appears. Click on the
Finish button.

DPM Command Line is now upgraded.
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3.6. Upgrading PackageDescriber
The following describes how to upgrade PackageDescriber.
After you perform an upgrade installation, you need to re-do the initial setup as
noted in "Section 6. Package Describer" in the Reference Guide.
The procedure below is for DPM unbundled product. Parts of this procedure will
vary from those for SSC product. For SSC product, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine to be upgraded by user with Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select PackageDescriber.

If you want to upgrade PackageDescriber in an environment where UAC is enabled
on Windows Vista, be sure to follow the procedure below.
(1)On the DeploymentManager Setup Screen, click on the Exit button.
(2)Using Explorer, etc., right-click on the following files and select Run as
Administrator.
•For SSC product: <Install media>:\DPM\Launch.exe
•For DPM unbundled product: <Install media>:\Launch.exe
DeploymentManager
Setup
screen
appears
again.
Select
(3)The
PackageDescriber.
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(2) The Selection of Installation Method screen appears. Select Custom Installation, remove the
checkmark from JRE, and click on the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.

(3) The Setup Type screen appears. Check Overwrite Install and click on the Next button.

(4) An overwrite confirmation screen appears. Click on the OK button.
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(5) The Maintenance Complete screen appears. Click on the Finish button.

PackageDescriber is now upgraded.
*If you change the Java settings, enable the changes by restarting the machine at your convenience
before using PackageDescriber.
You can overwrite PackageDescriber from the Programs and Features screen of
Control Panel as well.
In DPM Package Describer, select the Change button to display the Setup Type
screen of PackageDescriber. Then, overwrite PackageDescriber by following the
above Steps (3) to (5).
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3.7. Precautions: Upgrading
Ver4.0/4.1/4.2/4.3

from

DPM

If you want to upgrade from DPM Ver4.0/4.1/4.2/4.3, stop all DPM related services. (If a service does
not stop, end the process from Windows Task Manager). For DPM services, see the manuals of the
respective versions.
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This chapter describes how to uninstall DPM.
The items covered in this chapter are as follows:

•
•
•
•
•
•

4.1
4.2
4.3
4.4
4.5
4.6

Before Uninstalling DPM. ....................................................................................... 84
Uninstalling the DPM Server. ................................................................................. 84
Uninstalling the DPM Client. .................................................................................. 86
Uninstalling Image Builder (Remote Console). ....................................................... 91
Uninstalling DPM Command Line. ......................................................................... 93
Uninstalling PackageDescriber. ............................................................................. 95
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4.1. Before Uninstalling DPM
4.1.1.

Uninstall Precautions

The following describes how to uninstall each function of DPM.
Before starting the uninstall process, finish DPM related tasks.
If Event Viewer is running, close Event Viewer as well.

4.2. Uninstalling the DPM Server
If you want to uninstall the DPM Server, follow the procedure below.
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter
Installation Guide as well.
Do not execute the uninstall process from the Programs and Features screen.
If do so may not uninstall the program properly.
Log in to the machine where the program is to be uninstalled using a user with Administrator
authority.
(1) From the Start menu of the DPM Server, select All Programs -> DeploymentManager ->
Uninstall DPM Server. The Setup Type screen appears. Select Uninstall and click on the Next
button.
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(2) The Confirm Uninstall screen appears. Click on the OK button.

(3) The Setup Status screen appears and the uninstall process begins. When the Maintenance
Complete screen appears, click on the Finish button.

If the components below are not used by other applications, uninstall the components.
■ Uninstalling the Microsoft SQL Server 2008 R2 Native Client
Uninstall the Native Client by following the procedure below.
1) Select Control Panel from the Start menu, the Control Panel screen appears.
2) On the Control Panel screen, select Programs and Features. The Programs and Features
screen appears.
3) Select Microsoft SQL Server 2008 R2 Native Client from the Programs and Features screen
and click Uninstall.
■ If you upgraded the program from a version prior to DPM Ver6.0, please uninstall the following
components using the same process as uninstall the Microsoft SQL Server 2008 R2 Native Client.
-Microsoft SQL Server 2005
-Microsoft SQL Server Native Client
-Microsoft SQL Server VSS Writer
-Microsoft SQL Server setup support files (English)
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4.3. Uninstalling the DPM Client
The following describes how to uninstall the DPM Client.

4.3.1.

Uninstalling the Windows (IA32/EM64T) Version

There are two ways to uninstall the DPM Client (Windows (IA32/EM64T): from the command prompt,
and from Programs and Features.
In either case below, perform the uninstall process while referring to the section,
"Uninstalling the DPM Client from Programs and Features." In all other cases,
perform the uninstall process while referring to the section, "Uninstalling the DPM
Client from the Command Prompt."
•When DeploymentManager appears on the Programs and Features screen
•Windows Server 2008 (Server Core install)
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter
Installation Guide as well.


Uninstalling the DPM Client from the Command Prompt
 For the following operating systems, read "WINNT" as "Windows", and proceed
with the operations.
•Windows Server 2008 Standard/Enterprise/Datacenter
•Windows Server 2003 Standard Edition/Enterprise Edition/Datacenter Edition
•Windows Server 2003 R2 Standard Edition/Enterprise Edition/Datacenter Edition
•Windows XP Professional
 For the EM64T architecture machine, read "system32" as "SysWOW64", and
proceed with operations.

Log in to the machine where the program is to be uninstalled using a user with Administrator authority.
(1) Start the command prompt and move to the folder where the DPM Client is installed.
Example)When the DPM Client is installed on the C drive
C:\> cd /d %systemroot%\system32
(2) From the command prompt, execute the commands in the following order to uninstall the remote
update service.
rupdsvc.exe –remove
del rupdsvc.exe
del clisvc.ini
Example) When the DPM Client is installed on the C drive
C:\WINNT\system32>rupdsvc.exe –remove
C:\WINNT\system32>del rupdsvc.exe
C:\WINNT\system32>del clisvc.ini
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(3) From the command prompt, execute the commands in the following order to uninstall the agent
service.
depagent.exe -remove
del depagent.exe
del depagent.dll
del depinfo.dll
del L4dpm.ini
del L4dpm.dll
Example) When the DPM Client is installed on the C drive
C:\WINNT\system32>depagent.exe -remove
C:\WINNT\system32>del depagent.exe
C:\WINNT\system32>del depagent.dll
C:\WINNT\system32>del depinfo.dll
C:\WINNT\system32>del L4dpm.ini
C:\WINNT\system32>del L4dpm.dll
(4) From the command prompt, execute the following commands to uninstall the automatic update
status display tool.
del DPMtray.exe
Example) When the automatic update status display tool is installed on the C drive
C:\WINNT\system32>del DPMtray.exe
(5) From the Start menu, move to the Programs folder.
Example) When the OS is installed on the C drive
C:\WINNT\system32>cd %allusersprofile%\Start Menu\Programs
(6) From the command prompt, execute the following command to delete the shortcut to the
automatic update status display tool.
Example) When the OS is installed on the C drive
C:\Documents and Settings\All Users\Start Menu\Programs> rmdir /s /q DeploymentManager
If the shortcut of the Automatic Update Status Display tool has not been created,
when the above mentioned command is executed, though an error is displayed,
there is no problem. Finish the command prompt.
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Uninstalling the DPM Client from Programs and Features.

(1) From the Start menu, select
DeploymentManager -> Remove.

Control

Panel

->

Programs

and

Features

->

For Windows Server 2008(Server Core installation), this is not displayed in
Programs and Features, so please run the following file from the command line.
•For IA32:
"%SystemDrive%\Program Files\InstallShield Installation Information\
{6F68AC00-5FFD-42DE-B52E-D690D3DD4278}\setup.exe" -runfromtemp
-l0x0011uninstall -removeonly
•For EM64T:
"%SystemDrive%\Program Files(x86)\InstallShield Installation Information\
{6F68AC00-5FFD-42DE-B52E-D690D3DD4278}\setup.exe" -runfromtemp
-l0x0011uninstall -removeonly

(2) The Setup Type screen appears. Select Uninstall and click on the Next button.

(3) The Confirm Uninstall screen appears. Click on the OK button.

DeploymentManager Ver6.0 Installation Guide
88

Uninstalling the DPM Client

(4) The Setup Status screen appears and the uninstall process begins. When the Maintenance
Complete screen appears. Click on the Finish button.

It is possible that the file will still be removed even if you select the Cancel button
during the uninstall process. If this happens, insert the install media in the DVD
drive, and overwrite install the DPM Client. After this, please re-uninstall.

4.3.2.

Uninstalling the Linux (IA32/EM64T) Version

The following describes how to uninstall the DPM Client [Linux (IA32/EM64T) version].
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter
Installation Guide as well.
(1) Log in to the machine where the DPM Client (Linux) is installed as root account.
(2) Insert the install media into the DVD drive.
(3) Mount the install media.
# mount /mnt/dvd




In the case of Red Hat Enterprise Linux AS4/ES4 and SUSE Linux Enterprise
9, switch "/mnt" with "/media" and continue to operate.
For SUSE Linux Enterprise 10/11, proceed with the uninstall while reading
"/mnt/dvd" as "/media/<install media volume label>" below.

• For SSC product: # cd /mnt/dvd/DPM/Linux/ia32/bin/agent
• For DPM unbundled product: # cd /mnt/dvd/Linux/ia32/bin/agent
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(4) Execute depuninst.sh.
#./depuninst.sh
Depending on the execution environment, if you don't have the execute permission
of depunist.sh on the install media, you may not be able to execute it.
In this case, copy the DPM client module in the Linux directory on the DVD to the
correct directory on the hard disk, and then execute chmod command like the
example below to grant permission for all of the files and then run depuninst.sh.
Example)
# cd/mnt/copy destination directory/agent
# chmod 755 *
* The save location for the DPM client installer is as below.
For SSC product: <Install media>: /DPM/Linux/ia32/bin/agent
For DPM unbundled product: <Install media>: /Linux/ia32/bin/agent
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4.4. Uninstalling
Console)

Image

Builder

(Remote

If you want to uninstall Image Builder (Remote Console), follow the procedure below.
Do not execute the uninstall process from the Programs and Features screen. Doing
so may not uninstall the program properly.
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter Installation
Guide as well.
Log in to the machine where the program is to be uninstalled using a user with Administrator authority.
(1) From the Start menu of the machine where Image Builder (Remote Console) is installed, select
All Programs -> DeploymentManager -> Uninstall Image Builder. The Setup Type screen
appears. Select Uninstall and click on the Next button.

(2) The Confirm Uninstall screen appears. Click on the OK button.
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(3) The Setup Status screen appears and the uninstall process begins. When the Maintenance
Complete screen appears, click on the Finish button.
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4.5. Uninstalling DPM Command Line
The following describes how to uninstall DPM Command Line.
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where the program is to be uninstalled using a user with Administrator authority.
(1) From the Start menu, select Control Panel -> Programs and Features ->
DeploymentManager (DPM command line) -> and click on the Remove button.
(2) The Setup Type screen appears. Select Uninstall and click on the Next button.

(3) The Confirm Uninstall screen appears. Click on the OK button.
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(4) The Setup Status screen appears and the uninstall process begins. When the Maintenance
Complete screen appears, click on the Finish button.
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4.6. Uninstalling PackageDescriber
The procedure below is for DPM unbundled product. Parts of this procedure will vary
from those for SSC product. For SSC product, see the SigmaSystemCenter
Installation Guide as well.
Log in to the machine where the program is to be uninstalled using a user with Administrator authority.
(1) Insert the install media into the DVD drive. The DeploymentManager Setup screen appears.
Select PackageDescriber.

(2) The Selection of Installation Method screen appears. Select Custom Installation, remove the
checkmark from JRE, and click on the OK button.
Clicking Cancel returns the screen to the DeploymentManager Setup screen.

If you want to uninstall JRE Update24, do so from Programs and Features.
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(3) The Setup Type screen appears. Select Uninstall and click on the Next button.

(4) The Confirm Uninstall screen appears. Click on the OK button.

The Confirm Uninstall screen appears once again.
Click the Yes button removes locally created packages as well.
If you do not want to remove locally created packages, click the No button.

If you select the No button, the Packages folder under the PackageDescriber
installation folder remains as is.
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(5) The Maintenance Complete screen appears. Click on the Finish button.

PackageDescriber is now uninstalled.
* If you changed the JRE6 Update24 settings, to enable the changes, please restart the machine
before using PackageDescriber at your convenience.
You can uninstall PackageDescriber from the Programs and Features screen of
Control Panel as well.
In DPM PackageDescriber, click on the Change button or the Remove button to display
the Setup Type screen of PackageDescriber. Then, uninstall PackageDescriber by
following Steps (3) to (5) above.
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P a rt I I

Environment
Configuration

This section describes how to construct the environment after installing and before operating DPM.

•

5

Preparing for DeploymentManager Operation. ..................................................... 101
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5.

Preparing for DeploymentManager
Operation

This chapter describes how to set initial DPM settings.
The items covered in this chapter are as follows:

•

5.1

Preparing for DPM Operation............................................................................... 102
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5 Preparing for DeploymentManager Operation

5.1. Preparing for DPM Operation
The following describes the setup required when using DPM for the first time. Be sure to carefully read
this section before working with DPM.

5.1.1.

Starting the Web Console

Start the Web Console following the procedure below.
(1) Start the web browser.
 Disable the browser cache settings.
You can disable the settings as follows:
•For Internet Explorer 7/8
1) From the Tools menu of Internet Explorer, select Internet Options and, on
the General tab, click Settings under Browsing History.
2) The Temporary Internet Files and History Settings screen appears.
Under Check for newer versions of stored pages, select Every time I
visit the webpage and click on the OK button.
 Enable the browser JavaScript settings.
•For Internet Explorer 7/8
1) From the Tools menu of Internet Explorer, select Internet Options and, on
the Security tab, click on the Sites button under Trusted sites.
2) The Trusted sites screen is displayed, so enter the DPM URL and click on
the Add button. Please remove the check from "Require server verification
(https:) for all sites in this zone".
When you specify a value other than 100% under Zoom of the Page menu of
Internet Explorer 7/8, the text may appear in a size other than the specified size.
(2) Enter the following URL in the address bar of the browser to start the Web Console.
URL: http://Host/DPM/Login.aspx
In the Host area, enter the host name or IP address of the management server to be
connected from the Web Console.
The area is not case sensitive.
If the host name includes a character string (excluding single-byte alphanumeric
characters and hyphens "-") not recommended by Windows, specify an IP address
in the address bar area of the browser.
An error may occur during Web Console startup when the host name is specified.
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(3) The Login screen appears.

5.1.2.

Logging into DPM

To use DPM functions, you will need to set up user authorities.
Enter a user name and password, and click on the Login button. (Entry is required.)
The user name and password for the user with Administrator authority can use DPM
immediately after installation are as follows:
•User name "admin"
•Password "admin"
Be sure to change the password after login. About how to change the password of a
logged in user, see Section 5.1.3, "Setting Up Login Users." If you forget the
password after you have changed it and only you has been registered, you will no
longer be able to log into the system and will have to reinstall the program.
Once you begin operation, add and use other users not "admin" user. For details on
adding users and user authorities, see Section 2.2, "User Icons" and Section 2.3,
"User List," in Reference Guide.
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After login, the Web Console appears. On the Web Console, the Notice dialog box appears. Check
the contents.

5.1.3.

Setting up Login Users

Set up the login users as described below. You can change passwords, show/hide the Notice dialog
box, and set the number of items to be displayed on one page of the list screen under Account
Setting. For details on the settings of this screen, see Section 1.1.2, "Accounts," in Reference Guide.
(1) After you log into the system, click Account on the title bar of the Web console and the Account
Setting screen appears.
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(2) To change the password, check the Change password check box, and enter the password.
(3) If you do not want to display the Notice dialog box that appears at login, remove the checkmark
from the Show Notice Dialog check box.
(4) Set the number of items to be displayed on one page of a list screen.
While list screens such as the Group List screen on the main window allows you to change the
number of items to be displayed on the screen, the values set at here affect the number of items
shown in list screen. If the number is set to "20, 50, 100" (default value), for example, you can
select one of these values from the combination box. When the screen opens, the number of
items will be 20, which is the first of the three settings.
(5) Click on the OK button.
The setting becomes effective at the next login of the user.

5.1.4.

Registering the License Key



Only users with Administrator authority can add or remove licenses.
For SSC product license registration, see the SigmaSystemCenter Installation
Guide.

To use DPM, you must register the license key.
Register the license key following the procedure below.







The number of licenses is not the number of managed machines that can
execute scenarios simultaneously by DPM, but rather the total number of
managed machines which are introducted, operated, and managed by DPM.
You can only register managed machines up to the number of purchased
licenses.
There are two types of licenses: a server target license and a client target
license. For license details, see Section 2.3.2, "Product Configuration and
Licenses" in First Step Guide.
If you do not want to register the license key, your trial period will be for 30 days
with up to 10 machines can be registered. After 30 days, you can't use DPM
any more.

(1) On the Web Console, click Management in the title bar to switch to the Management view.
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(2) Clicking the License icon in the Management tree displays the Registration License List
screen.

(3) Click Add License Key in the Configuration menu. Add License Key screen appears.
(4) When a license key is entered in the Add License Key screen and you click on the OK button,
the entered license key information is registered. If you want to register multiple license keys,
repeat Steps (3) to (4) according to the number of license keys.
License is case sensitive, please enter it correctly.
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Appendix A Silent Installation
You can install the DPM Server and DPM Client by silent installation.
The silent installation command is stated below.
 Do not change the specified order of silent installation options.
 Be sure to enter the input value inside double-quotation marks (").
[Excluding the DPM Client for Linux (IA32/EM64T)]
 Do not enter a space between the option and equal sign ("=").
 When you enter an option you want to specify, the entry is not upper/lower case
sensitive.
 Some options may be omitted.
■ The following describes how to execute silent installation.

(1) Insert the install media into the DVD drive of the machine in which you want to install the
program.
(2) Start the command prompt, and move to the folder that stores the installer of the function you
want to install by silent installation. [For the DPM client for Linux (IA32/EM64T) as well, move to
the folder that stores the installer).
The folder that stores the installer for each function is shown below.
Read the folder that stores the installer as follows: (The folder for the DPM
unbundled product is stated below).
•For DPM unbundled product: <Install Media>:\
•For SSC product: (Installation DVD):\DPM
Function
DPM Server
DPM Client(Windows(IA32))
DPM Client(Windows(EM64T))
DPM Client(Linux(IA32/EM64T))

Storage Folder
<Install Media>:\Setup\DPM
<Install Media>:\TOOLS\SERVICES\IA32
<Install Media>:\TOOLS\SERVICES\AMD64
<Install Media>:\Linux\ia32\bin\agent

(3) If you want to install the DPM Server/DPM Client (Windows (IA32/EM64T)) by silent installation,
copy the parameter files (extension: iss) for silent installation from the folder that stores the
installer of the function you want to install to the local HDD. (In this section, the files are copied to
the following folder as an example).
C:\SilentInstall
For silent installation parameter files, see the following section, "Creating Silent Installation
Parameter Files" for an explanation of each of the components.
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(4) Execute the silent installation command. The specific command is stated under the description of
the corresponding component.
■ The silent installation arguments are described below.
Abbreviation
Silent Mode

Option Name
/s

Silent
installation
parameter files

/f1

Log
Output
Destination
Silent Mode

Meaning
Starts silent mode.
Parameter files for silent installation.
For further details, see how to create silent installation
parameter files described later. The command
examples described in the following employ a case
example where silent installation parameters files are
copied directly under "C:\SilentInstall."

/f2

Specifies the output destination for the Silent Install log.

SILENTDPM

Silent Mode
The path for installing the DPM Server.
Specify an absolute path using 255 characters or less.
Example)
C:\Program Files\NEC\DeploymentManager
The IP address of the management server.
Specify the IP address using numbers and dots.
Example)
192.168.0.1
X can be specified using 0, 1, or 2.
If you specify 0: The port will be not added as an
exception in firewall settings.
If you specify 1: The port will be added as an exception
and communication is enabled.
If you specify 2: The port will be added as an exception,
but communication is not enabled.
Specify the SQL Server 2008 R2 Express type (x64 or
x86).
x86: SQL Server 2008 R2 Express(x86) will be
installed.
x64: SQL Server 2008 R2 Express(x64) will be
installed.
Example) x86
If the SQL server is already installed, the
specification is invalid.

Installation path

INSTALLDIR

Management
Server IP

MANAGEMENT
SERVERIP

Firewall

FIREWALL

SQL
Architecture

SQLARCH
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Installing, Upgrading, and Uninstalling the
DPM Server
■ Installing
Setup.exe /s /f1"C:\SilentInstall\DPM_MNG_Setup.iss"
SILENTDPM INSTALLDIR="install path" MANAGEMENTSERVERIP="Management
Server IP" FIREWALL=x SQLARCH="SQL Architecture"
If you install the DPM server on a computer with multiple LAN board and omit
MANAGEMENTSERVERIP, the address recognized may be for an unintended LAN
board. It is recommended, therefore, that you do not omit the
MANAGEMENTSERVERIP option and specify the IP address that is to be used by the
management server (DPM Server) for communication. For the IP address used by the
management server (DPM Server) for communication, see Section 2.7.1, "Detailed
Configuration," in Reference Guide.

Options that can be omitted
INSTALLDIR
MANAGEMENTSERVERIP
FIREWALL

SQLARCH

Setting value
%ProgramFiles%\Provisioning\DeploymentMana
ger
The IP address of the computer where silent
installation was performed.
"1". The port used by the DPM Server is added as
an exception and communication is enabled.
For a list of ports used, see Appendix D, "Network
Port and Protocol List," in Reference Guide.
In the case the OS is x86, the SQL Server 2008
R2 Express(x86) is installed.
In the case the OS is x64, the SQL Server 2008
R2 Express(x64) is installed.
If the SQL server is already installed, do not
execute anything.
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■ Upgrade Installation

Setup.exe
/s
/f1"C:\SilentInstall\DPM_MNG_RESetup.iss"
FIREWALL=x SQLARCH=" SQL Architecture"

SILENTDPM

Upgrading the DPM Server is only possible if DPM Ver4.0 or later is installed.

Options that can be omitted
FIREWALL

SQLARCH

Setting value
"1". The port used by the DPM Server is added
as an exception and communication is enabled.
For a list of ports used, see Appendix D,
"Network Port and Protocol List," in Reference
Guide.
In the case the OS is x86, the SQL Server 2008
R2 Express(x86) is installed.
In the case the OS is x64, the SQL Server 2008
R2 Express(x64) is installed.
If the SQL server is already installed, do not
execute anything.

■ Uninstall
Setup.exe /s /f1"C:\SilentInstall\DPM_MNG_Uninst.iss" SILENTDPM
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Installing the DPM Client
■ Install the Windows (IA32/EM64T) version as described below.
■ Installing
Setup.exe /s /f1"C:\SilentInstall\DPM_CLI_Setup.iss" SILENTDPM
DPMSERVERIP="Management Server IP "FIREWALL=x
■ Upgrade Installation
Setup.exe /s /f1"C:\SilentInstall\DPM_CLI_RESetup.iss" SILENTDPM
DPMSERVERIP="Management Server IP"
The following options may be omitted. The value that is set if omitted is as below.
Options that can
be omitted
DPMSERVERIP

FIREWALL

Setting value
The management server IP address set for the installed
DPM Client.
"1". The port used by the DPM Client is added as an
exception, and communication is enabled.
For a list of ports used, see Appendix D, "Network Port
and Protocol List," in Reference Guide.

■ Uninstall
Setup.exe /s /f1"C:\SilentInstall\DPM_CLI_Uninst.iss" SILENTDPM
■ Install the Linux (IA32/EM64T) version as described below.
■ Installing
depinst_silent.sh Management Server IP > /var/temp/Inst_DPM_Lin_Cli.log
■ Upgrade Installation
depinst_silent.sh Management Server IP > /var/temp/Inst_DPM_Lin_Cli.log
■ Uninstall
depuninst.sh > /var/temp/Inst_DPM_Lin_Cli.log
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■ DPM Client [Windows (IA32/EM64T)] Parameter Creation Method and Silent Installation
You can also perform silent installation by preparing the parameter files for silent installation
following the procedure below.

Create a parameter file for silent installation

Prepare for installation

Perform silent installation

■ Creating the Parameter Files for Silent Installation
(1) Prepare the machine for creating the parameter files.
(2) Log in to the machine prepared in Step (1) using a user of Administrator authority.
(3) Insert the install media into the DVD drive.
(4) From the Start menu, select Run, enter cmd in the open column, and click on the OK button.
The command prompt appears. Execute the command below.
SSC product:
<Install Media>:\DPM\TOOLS\SERVICES\Machine architecture\setup.exe –r
DPM unbundled product:
<Install Media>:\TOOLS\SERVICES\Machine architecture\setup.exe –r
*The name of the "Machine architecture" folder is as follows:
For IA32 : IA32
For EMT64 : AMD64
Example)<Install Media>:\DPM\TOOLS\SERVICES\IA32\setup.exe –r
(5) The setup wizard starts. Enter the required values and perform setup. The entered values and
operations performed at this time are recorded as parameter files.
(6) The parameter file setup.iss for silent installation is created in the Windows system folder.
The Windows system folder by default is as follows:
Windows 2003/2008 • •C:\WINDOWS
Windows 2000 • • • • • C:\WINNT
For other operating systems, check the environment variable "%Systemroot%."
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■ Prepare the Installer.
(1) Insert the install media into the DVD drive, and copy the folder below located on the install media
to an arbitrary location.
For SSC product: (Install media):\DPM\TOOLS\SERVICES\Machine Architecture
For DPM unbundled product: <Install Media>:\TOOLS\SERVICES\Machine
Architecture
*The name of the "Machine Architecture" folder is as follows:
•For IA32 : IA32
•For EMT64
: AMD64
Example)<Install Media>:\DPM\TOOLS\SERVICES\IA32
(2) Copy setup.iss that was created in advance to the folder copied in Step (1).
Preparation is now complete.
■ Execute Silent Installation.
(1) From the Start menu, select Run, enter cmd in the open column, and click on the OK button.
The command prompt appears. Execute the command below.
Example)
When the folder is copied directly under the C drive
C:\IA32\setup.exe -s
 The parameter files for silent installation need to be created for each OS.
 It is recommended to fully check whether installation properly works with the
created parameter file.
 The parameter files for installation can only be used with Windows
(IA32/EM64T).
 For version EM64T, run "C:\AMD64\setup.exe –s."
 Silent installation creates a log during installation in the folder where the
installer is stored. Thus, if the installer is stored on media such as a DVD that is
not capable of writing, the log files cannot be created, causing installation
failure.
In such a case, specify the output destination of the log files using parameters
as follows:
Setup.exe -s -f2"c:\temp\clientsvc.log"
This ends the explanation of the silent installation execution procedure.
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Server
･Package Web Server Setting Method for IIS6.0(Windows Server 2003)
(1) From the Start menu, select Control Panel -> Add or Remove Programs.
(2) Click Add/Remove Windows Components. The Windows Components Wizard screen appears. Select
Application Server and then click on the Details button.
(3) The Application Server screen appears. Check Internet Information Services (IIS), and click OK.
(4) The screen returns to the Windows Components Wizard screen. Click Next. The processing is executed and
the Finish button appears. Installation is now finished.
(5) Create a folder that can be accessed from PackageDescriber.





If you want to specify a folder that is shared to network machines for the Web
shared folder, it is recommended that you assign the folder to the network
drive in advance. If the folder is not assigned to the network drive, access to the
network computer common folder may fail.
Verify that the Web shared folder has read and write attributes.
The created package will be stored in the Web shared folder. Be sure to
secure enough free space.

You can install PackageDescriber on the same computer as the Package Web
Server.
(6) From the Start menu, select Control Panel -> Administrative Tools -> Internet Information Services
Manager. The following screen appears.
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(7) Select Web Sites -> Default Web Site, right-click, and select New -> Virtual Directory.

(8) The Virtual Directory Creation Wizard screen appears. Click on the Next button.
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(9) The Virtual Directory Alias page appears. Enter any alias, and click on the Next button.

(10) A page asking for the directory path then appears. Specify the folder created in Step (5) and click on the Next
button.
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(11) The Virtual Directory Access Permissions page appears. Remove the Run Scripts (Such As ASP)
checkmark, and click on the Next button.

If Run Scripts (Such As ASP) is checked, attempts to download script file
packages may fail.
(12) The Completion page appears. Click on the Finish button to close the screen.

DeploymentManager Ver6.0 Installation Guide
120

(13) Next, click Internet Information Services -> Default Web Site, right-click on the entered alias name from (9),
and display Properties.
(14) Select the Directory Security tab, and click on the Edit button in the Authentication and access control
group box.
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(15) The Authentication Methods screen is displayed. Then remove the checkmark from Integrated Windows
authentication under the Authenticated access group box, and click on the OK button.

For the authentication method, use Anonymous access or Basic Authentication.
For details, see Section 4.3, "Automatically Registering Packages on Multiple DPM
Servers," in Operation Guide.

DeploymentManager Ver6.0 Installation Guide
122

(16) To download Windows Server 2008/Windows Vista/Windows 7 service pack/HotFixes/applications, select the
HTTP Headers tab and click on the MIME Types button.

(17) The MIME Types screen appears. Click on the New button, enter msu as the extension and
application/octet-stream as the MIME type, and click on the OK button.
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(18) Using the same procedure as in Step (17), enter msp as the extension and application/octet-stream as the
MIME type.
• Package Web Server setting method for IIS 7.0 (Windows Server 2008)/IIS7.5 (Windows Server 2008 R2)
Depending on the IIS version, some screens may not appear.


If supplying HTTP service or setting user authentication using IIS, enable Basic
Authentication and disable Common Authentication.
• IIS7.0 (For Windows Server 2008):
1) From the Start menu, select Administrative Tools -> Internet Information Service (IIS)
Manager.
2) The Internet Information Service (IIS) Manager screen is displayed. Select created
virtual directory from the left side of the screen and double click on Authentication in
the middle of the screen.

3) Right click on Basic Authentication in the middle of the screen and click on Enable.
(1) From the Start menu, select Administrative Tools -> Server Manager.
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(2) The Server Manager screen appears. Select Roles on the left-hand pane, and then click on Add Roles on the
right-hand pane.

(3) The Add Roles Wizard appears. Click on the Next button.
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(4) The Select Server Roles screen appears. Enter a check by Web Server (IIS).

(5) The following screen appears. Click on the Add Required Features button.

(6) The screen returns to the Select Server Roles screen. Click on the Next button.
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(7) On the Web Server (IIS) screen, click on the Next button.

(8) On the Select Role Services screen, check Basic Authentication and click on the Next button.
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(9) On the Confirm Installation Selections screen, click on the Install button.

(10) On the Installation Results screen, check the installation details and click on the Close button.

(11) Create a folder that can be accessed from PackageDescriber.





If you want to specify a folder that is shared to network machines for the Web shared
folder, it is recommended that you assign the folder to the network drive in advance. If the
folder is not assigned to the network drive, access to the network machine common folder
may fail.
Verify that the Web shared folder has read and write attributes.
The created package will be stored in the Web shared folder. Be sure to secure enough
free space.
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You can install PackageDescriber on the same machine as the Package Web Server.
(12) From the Start menu, select Control Panel -> Administrative Tools -> Internet Information Service
(IIS) Manager.
(13) The Internet Information Service (IIS) Manager screen is displayed. Right click on Default Web Site and
click on Add Virtual Directory.

(14) The Add Virtual Directory screen is displayed. Click on the OK button after the following settings.
•Alias
: Optional alias name
•Physical path : Folder created in (11)
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(15) To download Windows Server 2008 service pack/HotFixes/applications, double click on MIME Types in the
middle of the screen.

(16) The Mime Types screen is displayed in the middle of the screen and click on Add... on the right side of the
screen.
(17) The Add Mime Type screen is displayed. Click on the OK button after the following settings.
•Extension : msu
•Mime Type: application/octet-stream

(18) Using the same procedure as in Steps (16) to (17), enter msp as the extension and application/octet-stream as
the MIME type.
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Appendix C Setting
Protocol

up

Multicast

Perform the setting for the multi-cast protocol routing on the switch connecting to DPM.
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Appendix D Setting up the DHCP Relay
Agent
Perform the setting for the DHCP relay agent on the switch connecting to DPM.
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Appendix E NFS Server Configuration
To use the OS clear installation (Linux) function, you will need to construct the NFS server.
If you want to configure the NFS server on Windows Server 2003, install Services for UNIX.
If configuring on Windows Server 2008, install Windows "Service for NFS (Network File System)" of
Server 2008.
For installation, refer to the manual provided with the product. You will need to restart the machine
after installation.
The method described below is for constructing the NFS server on the DPM Server. For precautions
when installing the NFS server on a different machine, see Section 3.5.6, "Precautions/Other," in
Operation Guide.
■ Method for configuring the NFS server
1) For Windows Server 2003, install Services for UNIX on the management server.
For Windows Server 2008, install "Service for NFS (Network File System)" on the
management server.
2) Set the exports folder under the Folder for Image set in the Web Console as an NFS shared
folder. (Shared name: exports)
To set the NFS shared folder (exports) on Windows Server 2008/Windows
Server 2003, the following settings are required:
1) Select Start -> Programs -> Administrative Tools -> Local Security
Policy -> Local Policies -> Security Options, enable Network access:
Let Everyone permissions apply to anonymous users, and restart the
management server.
(Note that when the machine participates in a domain and the domain
security policy option is disabled, even if the local security policy option is
enabled, the option will become disabled. For a domain controller, change
the domain security policy instead of the local security policy).
2) Open the Properties dialog box of the exports folder, click on the Security
tab, add Everyone, and check Read & Execute in the permissions area.
Note that the Read permission is unproblematic for only the ks folder under
the exports folder.







With Services for UNIX 3.0/3.5, after installation, select Start -> Control
Panel -> Administrative Tools -> Services, and open Properties of
Server for NFS. Then, change the startup type from Disabled to Manual or
Auto, apply the changes, and then start the services. The NFS Sharing tab
is then added to folder properties.
If you want to set up the NFS Sharing folder using Services for UNIX 3.0 or
3.5, open the properties dialog box of the exports folder, select Share this
folder on the NFS sharing tab, and check Allow anonymous access.
Next, click Permissions, check Allow root access, and click OK to close
the properties window.
To create an NFS shared folder in Windows Server 2008 R2, click on the
exports folder properties NFS Sharing tab, Manage NFS Sharing -> select
the Share this folder checkbox, click on the OK button and the screen
closes.
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 If you want to run the Red Hat Linux installation scenario on multiple machines concurrently using
Services for UNIX, verify the number of Client Access Licenses (CAL) for the OS of the
management server. The default value for the number of CALs for Windows Server 2003 is 5. The
scenario may not work properly if the number of machines executing the scenario simultaneously
exceeds the number of licenses. To ensure that the scenario proceeds normally, reduce the
number of machines or follow the procedure below.
Verifying the Number of Licenses
(1) On the management server, select Start -> Control Panel -> Administrative Tools.
(2) Select Licensing. The Enterprise – Licensing screen appears.
(3) Click on the Products View tab. Refer to the Per Server licenses purchased on the screen
to confirm the maximum number of connectable machines.
If the current number of licenses is less than the number required, reduce the number of machines
that will run the scenario. If you do not want to reduce the number of machines, purchase the
licenses and set the following settings.
Adding a License
(1) Click on the Server Browser tab. On the screen displayed, select Enterprise ->
WORKGROUP -> SERVER, and double-click Windows Server. The Choose Licensing
Mode window appears.
(2) On the Choose Licensing Mode screen, click Add Licenses. The New Client Access
License window appears.
(3) On the New Client Access License window, specify the desired number in the Quantity
area, and click on the OK button. On the next window that appears, check I agree that check
box and click on the OK button.
(4) The screen returns to the Choose Licensing Mode screen. Verify that the number of
concurrent users has increased in accordance with the setting. The settings are now set.
Close the screen.
If you want to construct the NFS server on Linux, refer to the following.
■ To start NFS server on Linux, execute the following commands:
# /etc/rc.d/init.d/portmap restart
# /etc/rc.d/init.d/nfs stop &> /dev/null
# /etc/rc.d/init.d/nfs start
■ To enable NFS services at startup, execute the following commands:
# /sbin/chkconfig --level 345 portmap on
# /sbin/chkconfig --level 345 nfs on
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Appendix F Upgrading the Database
To upgrade the database, please contact your sales or support representative about the database upgrade
procedure.
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Appendix G Revision History
 First Edition(Rev.001)(2011.08): New
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